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READ ME FIRST 
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In case you're not familiar with the terminology, 
Read Me First is quite often the name given to a 
computer file that contains important information 
for people to know prior to using an application. 

This section contains some important information to 
help you use this book so we thought we'd start 
with a Read Me First section. 

 

What skills and knowledge 
you will acquire... 

The skills and knowledge acquired in Microsoft PowerPoint 2016 - 
Advanced are sufficient to be able to use and operate the software 
effectively. 

What you'll need to know 
before beginning this 
course... 

Microsoft PowerPoint 2016 - Advanced assumes little or no knowledge of 
the software. However, it would be beneficial to have a general 
understanding of personal computers and the Windows operating system 
environment. 

 

The objectives of this guide… At the completion of this course you should be able to: 

create and work with SmartArt graphics 

create and work with charts 

create and work with tables 

import data into PowerPoint from a number of different applications 

edit inserted images 

draw and format shapes 

insert and work with different types of media 

create animations in a presentation 

set up a presentation for the required presentation mode 

save and share your presentations in other formats 

What you get in a chapter... Each chapter begins with a summary page listing the topics covered in 
that chapter. The chapter then consists of single-page topic sheets 
pertaining to the theme of the chapter. 

What you'll need to have 
before commencing this 
course... 

Many of the topics in this learning guide require you to open an existing 
file with data in it. These files can be obtained from your instructor and 

need the product code for this course which is PowPointAdvanced. 

As you work through this 
guide… 

It is strongly recommended that you close all open files, if any, prior to 
commencing each new chapter in this learning guide. Each chapter, 
where relevant, has its own set of exercise files and any from a previous 
chapter are no longer required.  

Where to from here... Have a look at the next page which explains how a topic page works, 
ensure that you have access to the exercise files (see above), and you're 
ready to make a start. 
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The majority of this book comprises single-page 
topic sheets. There are two types of topic sheets: 
task and reference. The layout of both is similar 
– an overview at the top, detail in the centre and 

additional reference (optional) material at the 
bottom. Task sheets contain a Try This Yourself 
step-by-step exercise panel in the detail area as 
shown below. 

 
Topic name 

 
General topic overview provides an introduction to the topic 

 
Try This Yourself (Task-based topic sheets) is a detailed step-by-step practice 
exercise for you to work through. In Reference topic sheets this is usually replaced 
by a box with reference information. 

 
In Task topic sheets screen shots and graphics provide a visual clue as to what 
will happen when you work through the Try This Yourself practice exercise. In 
Reference topic sheets the screen shots and graphics are used to visually 
represent information and concepts. 

 
The For Your Reference (optional) element provides a quick summary of the steps 
required to perform a task. These usually only appear in Task-based topic sheets. 

 
The Handy To Know (optional) element provides additional information such as 
alternate ways of accomplishing a task or further information providing handy tips.  

 

1 

2 

3 

4 
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WORKING WITH TOPIC SHEETS 
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CHAPTER 1 SMARTART 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of SmartArt 

 learn how to insert a SmartArt graphic 

 learn how to insert text into a SmartArt graphic 

 learn how to add shapes below the active shape 

 learn how to add shapes above the active shape 

 learn how to add shapes before and after the active 
shape 

 learn how to add an assistant 

 learn how to promote and demote shapes 

 learn how to switch a SmartArt graphic from right to left 

 learn how to resize SmartArt 

 learn how to apply a different layout 

 learn how to apply a colour scheme 

 learn how to apply a SmartArt style 

 learn how to delete shapes from a SmartArt graphic. 

Rather than constructing diagrams such as flow charts, process 
charts or organisation charts from scratch, PowerPoint includes a 
range of SmartArt graphics that you can use. SmartArt is a range 
of graphics designed to help you build simple or complex diagrams. 
Select a SmartArt graphic from the gallery and then customise it to 
suit your needs. SmartArt will help you to create professional-
looking diagrams in minutes. 

INFOCUS 
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UNDERSTANDING SMARTART 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

SmartArt allows you to visually communicate 
your important ideas and information. For 
example, you can use SmartArt graphics to 
depict processes, hierarchies, relationships and 

so on. By using SmartArt to communicate 
information, you can create visually-appealing 
diagrams that can say so much more than words 
alone. 

How To Use SmartArt 

SmartArt can be a simple flowchart depicting a 
process or a complex arrangement of shapes and lines 
used to show relationships. To work with SmartArt, 
simply select a layout from the SmartArt gallery that 
most closely represents the way you want to structure 
your information, then customise the SmartArt graphic 
by adding text and formatting the shapes. The picture 
to the right is an example of a SmartArt graphic used to 
list a range of complementary fuels. Presented in this 
way, dry subject matter can suddenly become more 
interesting to read. 

The SmartArt Gallery 

SmartArt graphics are available from the SmartArt gallery. Click on a category in the left pane to view 
a range of layouts for that category in the centre pane. Click on a layout to preview it in the right pane. 

There are eight categories of SmartArt graphics in the SmartArt gallery: 

List For items without a sequence, such as a list of key objects or concepts 

Process For items or steps with a specific sequence and end point 

Cycle For steps with a continuing sequence 

Relationship To illustrate relationships between things such as objects and people 

Matrix For grid-like diagrams 

Pyramid For a hierarchy of items, like the traditional food pyramid 

Picture To create picture galleries and collages, for example 

Office.com Connect to office.com to view the layouts available to download 
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INSERTING A SMARTART GRAPHIC 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To create diagrams using SmartArt graphics, 
you first need to open the SmartArt gallery. You 
then select a layout from one of the eight 
categories that will best depict the information 

you want to convey. Once you insert the graphic, 
you can then insert text and format the shapes as 
required. In this exercise, you will insert an 
organisation chart. 

1 
Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file 
SmartArt_1.pptx… 

 
Click on the Insert a 
SmartArt Graphic icon 
located in the centre of the 
content placeholder, as 
shown, to open the Choose 
a SmartArt Graphic dialog 
box 

Alternatively you could click 
on the Insert tab, then click 
on SmartArt in the 
Illustrations group. 

Let’s insert a graphic into 
the placeholder… 

 
Click on each category in 
the left pane, then click on 
the layout options in the 
centre pane to preview each 
layout in the right pane 

 
Click on Hierarchy in the 
left pane, then click on 
Organisation Chart in the 
centre pane to select this 
layout 

 
Click on [OK] to insert the 
SmartArt graphic 

The graphic is contained 
within a placeholder. You 
can click in any [Text] 
placeholder and type to add 
text 

 

3 

4 

For Your Reference… 

To insert a SmartArt graphic: 

1. Click on the Insert a SmartArt Graphic icon 

2. Select a category in the left pane 

3. Select a layout, then click on [OK] 

Handy to Know… 

 Among the numerous organisation chart 
layouts available in the SmartArt gallery, is a 
Picture and Name Organisation Chart. If 
you insert this graphic, you will see picture 
placeholders. Click on a picture placeholder 
to open the Insert Picture pane, select the 
picture, then click on [Insert]. 
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INSERTING TEXT INTO SMARTART 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Text is inserted into text placeholders, which 
contain the text within the corresponding shape. 
There are two ways to insert text into a SmartArt 
graphic. Either click on the [Text] placeholder 

and start typing, or display the Text pane and type 
text into it. Inserting text into the Text pane is 
generally the quicker method, as you don’t need to 
move to each shape before you type the text. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file SmartArt_2.pptx... 

 
Click on the SmartArt graphic 
to display the placeholder if 
necessary, then click on the 
tab on the left border of the 
placeholder to open the Text 
pane 

The tab will expand to open 
the Text pane, where each 
bullet point corresponds to a 
shape in the graphic... 

 
In the first bullet point, type 
Managing Director 

The text will appear in the 
corresponding shape in the 
chart. Notice also how the font 
size adjusts automatically... 

 
Press  to move down to the 

next bullet point (assistant) 
and type Legal Advisor 

 
Repeat step 3 to add the 
following entries: 

Administration Manager 
Financial Controller 
Marketing Director 

 
Click on Close at the top of the 
Text pane to close it 

 

1 

2 

4 

For Your Reference… 

To insert text into a SmartArt graphic: 

1. Click on the SmartArt graphic to display the 
placeholder, then click on the tab on the left 
border of the placeholder 

2. Type the text, using the arrow keys to move 
between entries (shapes) 

Handy to Know… 

 You can display and hide a SmartArt graphic 
Text pane by clicking in the SmartArt graphic 
to activate the placeholder, then clicking on 
Text Pane in the Create Graphic group on 
the SmartArt Tools: Design tab. 
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ADDING SHAPES BELOW 
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Although the range of SmartArt layouts make for 
a great start when creating diagrams, it is likely 
that you will need to customise the graphic to 
meet your needs. One way to customise 

SmartArt is to add shapes to the existing graphic. 
You can add shapes below the active (source) 
shape, which will appear below the active shape, 
one level down in the hierarchy. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the 
file SmartArt_3.pptx... 

 
Click on the text Managing 
Director to make the shape 
active 

A dashed line will appear 
around the shape, indicating it 
is active and you can edit it. 
Let’s add a shape one level 
below the active shape... 

 
Click on the SmartArt Tools: 
Design tab, then click on the 
drop arrow for Add Shape in 
the Create Graphic group and 
select Add Shape Below 

The shape will be inserted one 
level below and is active so you 
can start typing... 

 
Type Business Development 

You will now add the 
Accountant and Projects Officer 
who both report to the Financial 
Controller… 

 
Click on the text Financial 
Controller to make the shape 
active, then repeat step 2 to 
add a shape below 

 
Type Accountant, then click 
on Financial Controller and 
repeat step 2 to add another 
shape titled Projects Officer 

 

1 

2 

For Your Reference… 

To add a shape below: 

1. Click on the source shape to make it active 

2. Click on the SmartArt Tools: Design tab, 
then click on the drop arrow for Add Shape 
in the Create Graphic group 

3. Select Add Shape Below 

Handy to Know… 

 In SmartArt, you can add shapes below by 
typing text directly into the Text pane. To do 
this, open the Text pane, then click at the 
end of the text entry of the source shape. 

Press  to add a shape (bullet point) 

below it, then press  and type the text. 

5 
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ADDING SHAPES ABOVE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you add a shape above, the shape will 
appear one level above the active shape in the 
hierarchy. So, to add a higher position to an 
organisation chart, you click on or select the 

source shape (that is, the starting shape that you 
will add other shapes to) and then add a shape 
above it. Here you will add the CEO and General 
Manager to the hierarchy. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the 
file SmartArt_4.pptx... 

 
Click on the text Managing 
Director to make the shape 
active 

Let’s add the CEO to the 
hierarchy… 

 
Click on the SmartArt Tools: 
Design tab, then click on the 
drop arrow for Add Shape in 
the Create Graphic group and 
select Add Shape Above 

 
Type Chief Executive Officer 

 
Click on the text 
Administration Manager to 
make the shape active 

Let’s add the General Manager 
to the hierarchy… 

 
Repeat step 2 to add a shape 
above 

 
Type General Manager 

 

3 

5 

For Your Reference… 

To add a shape above: 

1. Click on the source shape to make it active 

2. Click on the SmartArt Tools: Design tab, 
then click on the drop arrow for Add Shape 
in the Create Graphic group 

3. Select Add Shape Above 

Handy to Know… 

 In SmartArt, you can add shapes above by 
inserting text into the Text pane. Open the 
Text pane, then click at the beginning of the 
bullet point entry of the source shape. Press 

 to insert a new entry, then press , 

and press  +  to promote the entry 

(one level up). Type the text. 

6 
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ADDING SHAPES BEFORE AND AFTER 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

As well as adding shapes to your SmartArt 
graphic that appear above and below the active 
shape in the hierarchy, you can also add shapes 
to appear either to the left of (before) or the 

right of (after) the active shape. When you add 
shapes before or after the active shape, the entry 
will appear on the same level of the hierarchy as 
the active shape. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file SmartArt_5.pptx... 

 
Click on the text Business 
Development to make the 
shape active 

Let’s add the Sales Manager 
to the hierarchy… 

 
Click on the SmartArt Tools: 
Design tab, then click on the 
drop arrow for Add Shape in 
the Create Graphic group 
and select Add Shape 
Before 

 
Type Sales Manager 

 
Click on the text 
Administration Manager to 
make the shape active 

Let’s add the Office Manager 
to the hierarchy, who also 
reports to the General 
Manager… 

 
Click on the drop arrow for 
Add Shape in the Create 
Graphic group and select 
Add Shape After 

 
Type Office Manager 

 

3 

6 

For Your Reference… 

To add a shape before or after: 

1. Click on the source shape to make it active 

2. Click on the SmartArt Tools: Design tab, 
then click on the drop arrow for Add Shape 
in the Create Graphic group 

3. Select Add Shape Before or Add Shape 

After 

Handy to Know… 

 In SmartArt, if you’re not satisfied with the 
position of a shape when you Add Shape 
Before or After, you can click on Move Up 
to move the shape across one position to the 
left, or Move Down to move the shape 
across one position to the right. 
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ADDING AN ASSISTANT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

An assistant, such as an Executive Assistant, 
generally reports to the CEO or Managing 
Director, but is not at the same level as other 
subordinates. For example, the CEO may have 

an Executive Assistant as well as other managers 
who report to them. For this reason, PowerPoint 
provides the Add Assistant tool to help account for 
these types of positions in the hierarchy. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the 
previous file with this 
exercise, or open the file 
SmartArt_6.pptx... 

 
Click on the text 
Managing Director to 
make the shape active 

Let’s add an Executive 
Assistant to the Managing 
Director… 

 
Click on the SmartArt 
Tools: Design tab, then 
click on the drop arrow for 
Add Shape in the Create 
Graphic group and select 
Add Assistant 

 
Type Executive 
Assistant 

 
Click on the text Sales 
Manager to make the 
shape active 

Let’s add Customer 
Service Reps… 

 
Repeat step 2 to add an 
assistant, then type 
Customer Service Reps 

 

2 

3 

For Your Reference… 

To add an assistant: 

1. Click on the source shape to make it active 

2. Click on the SmartArt Tools: Design tab, 
then click on the drop arrow for Add Shape 
in the Create Graphic group 

3. Select Add Assistant 

Handy to Know… 

 By default, assistants in SmartArt are 
placed one level below the active shape and 
appear on the left of the connecting line. 
Subordinate positions appear on the right of 
the connecting line. 

5 
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PROMOTING AND DEMOTING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Microsoft PowerPoint allows you to promote and 
demote shapes (or positions) in the hierarchy. 
This can save you from having to delete and 
recreate positions. When you promote or demote 

a shape in the hierarchy, any shapes below that 
shape are also promoted or demoted accordingly, 
and will move up or down one level in the 
hierarchy. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the 
file SmartArt_7.pptx... 

 
Click on the text Marketing 
Director to make the shape 
active 

The Business Development and 
the Sales Manager should 
actually report to the Marketing 
Director… 

 
Click on the SmartArt Tools: 
Design tab, then click on 
Promote in the Create Graphic 
group to promote the position of 
Marketing Director 

This is not right at all! The 
reporting structure is a mess… 

 
Click on Demote or press 

 +  to undo the change 

Let’s try another approach… 

 
Click on the text Sales 
Manager, then click on Demote 
in the Create Graphic group 

 
Click on Customer Service 
Reps, then click on Demote to 
reposition this shape below 
Sales Manager 

 
Click on Business 
Development, then click on 
Demote to reposition this shape 
also below Marketing Director 

 

2 

4 

For Your Reference… 

To promote or demote positions: 

1. Click on the source shape to make it active, 
then click on the SmartArt Tools: Design 
tab 

2. Click on Promote or Demote in the Create 
Graphic group 

Handy to Know… 

 You may not get what you expect when 
promoting and demoting positions in a 
SmartArt hierarchy. Sometimes it may just be 
easier to delete the existing position and then 
recreate it. 

6 
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SWITCHING SMARTART RIGHT TO LEFT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Right to Left tool allows you to switch the 
order of shapes in your SmartArt graphic. This is 
really the same as flipping or reversing the 
graphic. This also applies to any arrows that may 

appear in the graphic. So, whatever appeared on 
the left will appear on the right and vice versa. Note 
that you can only flip or reverse the entire graphic, 
not parts of the graphic. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file SmartArt_8.pptx... 

 
Click on the graphic to display 
the graphic placeholder if it is 
not already visible 

 
Click on the SmartArt Tools: 
Design tab, then click on 
Right to Left in the Create 
Graphic group 

The chart will be reversed. 
This layout is looking much 
better, let’s just double-check 
that we want to use this 
layout… 

 
Repeat step 2 to restore the 
original layout 

The other layout is 
preferable… 

 
Press  +  to reinstate 

the change, then click outside 
the placeholder to view the 
result 

 

1 

2 

For Your Reference… 

To switch SmartArt right to left: 

1. Click on the SmartArt graphic to display the 
graphic placeholder 

2. Click on the SmartArt Tools: Design tab, 
then click on Right to Left in the Create 
Graphic group 

Handy to Know… 

 In SmartArt, Right to Left is ideally suited for 
cycle and process diagrams, where it can be 
used to reverse the order of the process. 
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RESIZING SMARTART 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

By default, SmartArt will resize automatically to 
fit the placeholder and vice versa. As you add or 
delete shapes, for example, the graphic will 
adjust its size accordingly to fit the placeholder. 

However, you may want to increase or decrease 
the size of the graphic, and there are a couple of 
ways to do this: either drag on a placeholder 
handle, or specify the width and height. 

2 
Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file 
SmartArt_9.pptx... 

 
Click on the SmartArt 
graphic to make it active 

 
Point to the placeholder 
handle that appears in the 
middle of the bottom border 
until a double-headed arrow 
appears, as shown 

 
Click and drag the handle 
down, then release the 
mouse button 

The graphic is resized. Let’s 
use the controls on the 
Format tab to resize the 
height more precisely… 

 
Click on the SmartArt 
Tools: Format tab, then 
click on the up or down 
arrow for Height in the Size 
group to set it to 13 cm 

The chart now extends off 
the slide… 

 
Repeat step 4 to change 
Width to 21 cm 

 
Point to the border until the 
pointer is a four-headed 
arrow, then click and drag 
the organisation chart to 
reposition it as shown 

 

4 

6 

For Your Reference… 

To resize SmartArt: 

1. Click in the SmartArt graphic to activate it 

2. Click and drag on a placeholder handle to 
resize, or 

 Click on the SmartArt Tools: Format tab, 
then specify the Height and Width in the 
Size group 

Handy to Know… 

 Press  while dragging on a placeholder 

handle to resize from all four sides at once. 

 To position SmartArt, select the placeholder, 
then click on the SmartArt Tools: Format 
tab and click on Align and select an option. 
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CHANGING THE SMARTART LAYOUT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Each SmartArt category in the SmartArt gallery 
contains a range of layouts that you insert to 
create your diagrams. But if you’re not happy with 
the layout, you can easily apply a different one to 

your existing graphic. The shapes and text will 
reformat in line with the selected layout and 
changing the layout will not affect the structure of 
the diagram. 

2 
Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file 
SmartArt_10.pptx... 

 
Click on the SmartArt 
graphic to display the 
placeholder 

 
Click on the SmartArt 
Tools: Design tab, then 
click on the More arrow in 
the Layouts group to 
display a gallery of available 
layouts 

The current layout is 
outlined in orange... 

 
Point to different layouts to 
see the organisation chart 
reformatted in Live Preview 

The name of each layout will 
be displayed in a tool tip... 

 
Select Hierarchy to apply 
this layout 

 

3 

For Your Reference… 

To apply a different layout: 

1. Click on the SmartArt graphic to activate it 

2. Click on the SmartArt Tools: Design tab 

3. Click on More in the Layouts group 

4. Click on a layout to apply 

Handy to Know… 

 If you wish to see more available SmartArt 
layouts, you can click on More Layouts in 
the Layouts gallery to display the Choose a 

SmartArt Graphic dialog box. 

4 
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APPLYING A COLOUR SCHEME 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can change practically every aspect of 
SmartArt graphics, and changing the default 
colour scheme is no exception. There are many 
alternate colour schemes that you can apply to 

your SmartArt to ensure, for example, that the 
graphic conforms to the formatting requirements of 
the presentation. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file SmartArt_11.pptx... 

 
Click on the SmartArt graphic 
to display the placeholder 

 
Click on the SmartArt Tools: 
Design tab, then click on 
Change Colours in the 
SmartArt Styles group to 
display a gallery of colour 
schemes (or themes) 

The currently applied scheme 
is outlined in orange… 

 
Point to different colour 
schemes to see the SmartArt 
update in Live Preview 

 
Select Colourful – Accent 
Colours under Colourful to 
apply the colour scheme, then 
click outside the placeholder to 
view the result 

 

2 

3 

For Your Reference… 

To apply a colour scheme: 

1. Select the SmartArt graphic 

2. Click on the SmartArt Tools: Design tab, 
then click on Change Colours in the 
SmartArt Styles group 

3. Click on a colour scheme to apply it 

Handy to Know… 

 You can modify the format of individual 
shapes, lines and the text within a SmartArt 
graphic. To do this, click on a shape or line to 
select it (hold down  and click to select 

multiple shapes), or select the text, then click 
on the SmartArt Tools: Format tab and 
apply formatting as required. 

4 
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APPLYING A SMARTART STYLE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

There is a vast range of SmartArt formatting 
options available. Not only can you change the 
layout and colour scheme of your SmartArt to a 
style that suits your presentation, you can also 

apply styles to your SmartArt. Styles differ to 
layouts in that they include a range of effects for 
shapes, such as 3D effects, thereby enhancing the 
look of your graphic. 

2 
Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file SmartArt_12.pptx... 

 
Click on the SmartArt graphic 
to display the placeholder and 
make it active 

 
Click on the SmartArt Tools: 
Design tab, then click on More 
in the SmartArt Styles group 
to display the gallery of styles 

PowerPoint suggests a range 
of styles that best match the 
current document… 

 
Point to different styles to see 
the SmartArt update in Live 
Preview 

You may need to wait a 
moment for Live Preview to 
display the effect, as 3D 
effects can be quite memory-
intensive… 

 
Click on Moderate Effect 
under Best Match for 
Document to apply this style, 
then click outside the 
placeholder to view the result 

 

3 

4 

For Your Reference… 

To apply a SmartArt Style: 

1. Click on the SmartArt graphic to activate it 

2. Click on the SmartArt Tools: Design tab 

3. Click on More in the SmartArt Styles group 

4. Click on the desired style to apply it 

Handy to Know… 

 You can reset a SmartArt graphic to its 
original form (that is, the original layout), 
removing any formatting such as styles and 
colour schemes. To do this, activate the 
graphic, click on the SmartArt Tools: 
Design tab, then click on Reset Graphic in 
the Reset group. 
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DELETING SMARTART SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

As well as formatting your SmartArt graphic with 
the vast range of formatting options, you may 
also need to edit the graphic, such as deleting 
individual shapes or editing text. When you 

delete shapes in a SmartArt graphic, the graphic 
will adjust accordingly. Any lines connecting to that 
shape will also be removed. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file SmartArt_13.pptx... 

 
Click on the text Legal 
Advisor to activate the 
shape, then click on the 
border of the shape to select 
it, as shown 

Handles should appear 
around the shape but the 
cursor should not appear in 
the text... 

 
Press  

The shape will be deleted and 
the graphic will adjust 
accordingly... 

 
Repeat step 1 to select the 
shape titled Office Manager 

 
Press  

 

1 

2 

For Your Reference… 

To delete a shape from SmartArt: 

1. Click on the border of the shape to select it 

2. Press  or  

Handy to Know… 

 To delete multiple shapes at once, press 
 and click to select multiple shapes, then 

press . 

 To delete the entire SmartArt graphic, 
activate the graphic, click on the placeholder 
border to make sure no shapes are selected, 
then press . 

4 
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NOTES: 
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CHAPTER 2 CHARTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of charts 

 learn how to insert a chart using the ribbon 

 learn how to change the chart type 

 gain an understanding of chart elements 

 learn how to change the chart layout 

 gain an understanding of chart buttons 

 learn how to change the layout of chart elements 

 learn how to apply a chart style 

 gain an understanding of the chart format panes 

 learn how to format chart elements 

 learn how to edit data series 

 learn how to hide and show data series 

 learn how to work with pie charts. 

You can display data in rows and columns within a table on a slide. 
Alternatively, you can display the same data in a chart. 

Because charts let you present data in a visual format, you will find 
a chart is not only more visually appealing than a table but its data 
is often easier to understand. 

INFOCUS 
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UNDERSTANDING CHARTS 
 

 

 

 

 

 

 

 

 

 

 

 

Charts are used primarily to depict numerical 
data such as statistics or percentages in a 
graphical format that is easier to understand and 
quicker to digest than a list of numbers and 

figures. There are many different kinds of charts 
and some chart types suit certain purposes better 
than others. 

Charts 

Creating a chart in PowerPoint is easy. Simply click on the Insert tab, then click on Chart in the 
Illustrations group to display the Insert Chart dialog box. Click on a category in the left pane and select 
an option from the top of the right pane to display a thumbnail. If you point to the thumbnail in the right 
pane, it will zoom in so you can see it in greater detail. Once you have chosen a chart, click on [OK] and 
the chart will be inserted into the slide with the Excel worksheet open by default. The Excel worksheet 
contains the data to be displayed in the chart. Any data you add to the worksheet will be immediately 
reflected in the chart. 

 
Excel 
Worksheet 

When a chart is opened for editing, the data that is used to draw the chart is displayed 
in an Excel worksheet. Changes to the information in the Excel worksheet are 
immediately reflected in the chart. 

 
Chart Area The chart area contains the entire chart and all its elements. 

 
Vertical 
(Value) 
Axis 

An axis is a line that borders one side of the plot area providing a frame of reference 
for measurement or comparison in a chart. For most charts, data values are plotted 
along the value axis, which is usually vertical (the Y axis). In the example above, a 
vertical (value) axis title has not been included. 

 
Horizontal 
(Category) 
Axis 

Categories are usually plotted along the category axis, which is usually horizontal (the 
X axis). 

 
Data 
Series 

A data series is a collection of related data. Each data series relates to a column or 
row of data in the Excel worksheet and is usually represented in the chart by a colour, 
pattern or object depending on what kind of chart it is. For example, the yellow bars in 
the above chart represent a data series – in this case, the data in the column for 
Canada in the Excel worksheet. 

 

1 

2 

3 

4 

5 
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INSERTING A CHART USING THE RIBBON 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

There are several ways to insert a chart into 
PowerPoint. You can click on the Insert Chart 
icon in a content placeholder on a slide or click 
on Insert Chart in the Illustrations group on the 

Insert tab. After selecting the most appropriate 
chart type, an Excel window will open, into which 
you enter (or copy) the desired data. PowerPoint 
will then create the chart using the data. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file 
Charts_1.pptx… 

 
Navigate to and display 
slide 2 in the Slide window 

 
Click on the Insert tab then 
click on Chart in the 
Illustrations group to open 
the Insert Chart dialog box 

 
Ensure Column is selected 
under All Charts and ensure 
the first option is selected in 
the right pane, then click on 
[OK] to insert a chart 

An Excel spreadsheet opens 
automatically. Let’s enter the 
chart data into the Excel 
spreadsheet… 

 
Click in cell B1 and type the 
data as shown, pressing  

to move to the next cell 

The blue line shows the data 
that will be included in the 
chart, but we don’t want to 
include the data in row 5… 

 
Drag the bottom right corner 
of the blue range rectangle 
up until row 5 is excluded, 
then release the mouse 
button 

 
Click on Close to close the 
worksheet and view the 
result 

 

2 

4 

5 

For Your Reference… 

To insert a chart: 

1. Click on the Insert tab, then click on Chart in 
the Illustrations group 

2. Select the chart type and click on [OK] 

3. Enter the data in the Excel spreadsheet 

Handy to Know… 

 When you are editing the data of a chart, if 
you click on Edit Data in Microsoft Excel in 
the Quick Access Toolbar of the Excel 
spreadsheet, the spreadsheet will be opened 
in Excel so you have access to all the editing 
and formatting options available in Excel. 

6 
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CHANGING THE CHART TYPE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sometimes you may use different types of charts 
to represent the same data. Or you may decide, 
for example, that your data would be better 
displayed in a pie chart rather than a column 

chart. You can easily convert an existing chart to a 
different chart type in PowerPoint. You can also 
use this feature to test different chart types to find 
the one that will best represent your data. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the 
file Charts_2.pptx... 

 
Navigate to and display slide 2 
in the Slide window if required, 
then click on the chart to 
activate it 

The placeholder will display 
which means the chart can now 
be edited… 

 
Click on the Chart Tools: 
Design tab, then click on 
Change Chart Type in the 
Type group to open the 
Change Chart Type dialog box 

 
Click on Line in the left pane, 
then click on Line with 
Markers to select this chart 
type and click on [OK] to apply 
the change 

 
Repeat steps 2 and 3 to change 
the chart to a Stacked Area 
chart (under Area) 

Probably not the best way to 
represent our data… 

 
Repeat steps 2 and 3 to change 
the chart to a Clustered Bar 
chart (under Bar) 

Our data is represented clearly 
in this chart type 

 

3 

4 

5 

For Your Reference… 

To change the chart type: 

1. Click on the chart, then click on the Chart 
Tools: Design tab and click on Change 
Chart Type in the Type group 

2. Select the chart type 

3. Click on [OK] 

Handy to Know… 

 Some chart types will not be suitable for 
some data. For example, if you have defined 
five data series, you could not change the 
chart type to a pie chart, as pie charts 
represent data for only one data series. 
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CHART ELEMENTS 
 

 

 

 

 

 

Charts are made up of many chart elements – 
the chart title, data labels, legend, and more. 
Each of these elements can be individually 
formatted, moved, and in some cases, hidden or 

shown, to create exactly the chart you want for your 
presentation. The following diagram and 
accompanying text describes some of the main 
elements in a chart. 

 

 
Chart Title The name of the chart. 

 
Plot Area In a 2-D chart, the plot area is the area bounded by the axes and includes the data 

series. In a 3-D chart the plot area is the area bounded by the axes and includes 
the data series, category names and axes titles. In the example above, it also 
includes the horizontal gridlines. 

 
Chart 
Buttons 

There are three chart buttons and they are chart elements, chart styles and chart 
filters. These buttons only appear when a chart is selected and can be used to 
perform a range of basic functions. 

 
Legend The legend identifies the patterns or colours assigned to the data series or 

categories in a chart. 

 
Data 
Labels 

A data label is a label that provides additional information about a data marker, 
which represents a single data point or value that originates from a worksheet cell. 
Data labels can be applied to a single data marker, an entire data series or all data 
markers in a chart. 

 

1 2 

5 

4 

3 
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USING QUICK LAYOUTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After creating a chart, you can instantly change 
the layout of its various elements to one of the 
predefined layouts (known as quick layouts) 
provided by PowerPoint. Depending on the chart 

type, you can choose to display or hide the legend, 
chart titles, axes’ titles, data labels, data tables and 
gridlines. You can also change the location of the 
legend. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Charts_3.pptx... 

 
Navigate to and display slide 
2 in the Slide window if 
required, then click in the 
chart to activate it 

 
Click on the Chart Tools: 
Design tab, then click on 
Quick Layout in the Chart 
Layouts group to open a 
gallery of options 

Although no options are 
highlighted, Layout 3 is the 
default layout for this chart... 

 
Click on Layout 8 

Notice there are now Axis 
Titles… 

This layout has also displayed 
the chart title, which in our 
case, is superfluous since the 
slide title is the same as the 
chart title. But that’s ok, as 
you can quickly delete it using 
the Chart Tools: Layout tab or 
the Chart buttons as you’ll 
see later in this chapter 

 

1 

2 

For Your Reference… 

To use the quick layouts: 

1. Click on the chart 

2. Click on the Chart Tools: Design tab, then 
click on Quick Layout in the Chart Layouts 
group 

3. Click on the desired layout 

Handy to Know… 

 The number and style of the quick layouts 
that appear in the Chart Layouts gallery will 
depend on the current chart type. 

3 
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UNDERSTANDING CHART BUTTONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Chart Buttons are a quick and handy way of 
accessing formatting and editing options for your 
chart. They contain the basic functions necessary 
for creating a chart such as chart styles, options 

for chart elements and data filtering. You can also 
access Format panes for the chart elements via 

the chart elements button. 

Chart Buttons 

In addition to a comprehensive ribbon and shortcut menu from which you can access chart tools and options, 
PowerPoint also provides a quicker way to access certain chart options. 

Whenever you select a chart, three buttons appear next to the top right corner of a chart. These three buttons are 
called chart elements, chart styles and chart filters. When you click on one of these three buttons, a fly-out 
menu of options/commands appears for you to work with, as shown. 

 
cchart elements 

chart styles

 

chart filters 

Chart Elements Button 

The chart elements button provides you with options for how to label the data in a chart. To show/hide a chart 
element, simply click on the checkbox for that element so it appears with or without a tick. 

Pointing to an element will display a small grey arrow. Clicking on this arrow will open an additional fly-out menu 
that contains options specific to that element, such as where you would like the element placed on the chart. You 
can access even more formatting options for a chart element by selecting More Options from this menu which 
will open the Format pane specific to that chart element. 

Chart Styles Button 

The chart styles button provides you with options for working with the appearance of a chart. You can select a 

style or colour from the gallery of Style or Colour options to immediately apply it to the chart. 

Chart Filters Button 

Chart filters provides you with several options for working with the data in a chart. You have the ability to show or 
hide Series and Category values or names by checking or unchecking the specific checkboxes. Clicking on 
[Apply] will then apply this option to the chart. 

Clicking on Select Data will open the Select Data Source dialog box as well as the Excel spreadsheet. Using 
this dialog box you can select options for hiding or adding data series. 
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CHANGING THE LAYOUT OF CHART ELEMENTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PowerPoint provides numerous standard layouts 
for the selected chart type. While these may be 
fine for some situations, you can manually alter 
the layout of the various chart elements until you 

achieve the desired result. For example, you can 
add, remove or position labels including axis titles 
and legends. You can also display or hide 
trendlines, turn the plot area on or off, and more. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the 
previous file with this 
exercise, or open the file 
Charts_4.pptx... 

 
On slide 2, click on the 
chart to select it, then click 
on the chart elements 
button to display a fly-out 
menu 

Let’s remove the chart 
title... 

 
Click on the Chart Title 
checkbox so it appears 
without a tick  

The chart will expand to 
occupy the extra space. 

Because the bars are fairly 
small, let’s add data labels 
to clarify the figures... 

 
If necessary, repeat step 
1, then point to Data 
Labels until a small black 
arrow appears to the right, 
then click on the arrow to 
display a fly-out menu 

 
Click on Outside End to 
apply these data labels 

Data labels will appear to 
the right of each bar 
showing their actual value 

 

1 

2 

For Your Reference… 

To manually change the layout of chart 
elements: 

1. Click on the chart 

2. Click on the Chart Tools: Design tab 

3. Make the desired changes 

Handy to Know… 

 You can use the ribbon to change the layout 
of chart elements by clicking on the Chart 
Tools: Design tab and applying the options 
in the Chart Layouts group. 

3 
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APPLYING A CHART STYLE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

One advantage of applying a theme to a 
presentation is that each object you insert – be it 
a table, shape or chart – will be formatted with a 
default style that reflects the theme elements, 

such as the theme colours. In addition to the 
default chart style, you can apply one of many 
other built-in styles to your charts to ensure they 
complement your presentation. 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Charts_5.pptx... 

 
On slide 2, click on the chart 
to activate it 

 
Click on the Chart Tools: 
Design tab, then click on the 
More arrow in the Chart 
Styles group to display the 
Chart Styles gallery 

The gallery displays a range of 
complementary styles for the 
current chart. The current style 
is highlighted in orange... 

 
Point to the options to display 
a tooltip with the style name, 
then click on Style 7 to apply 
this style 

Let’s try a quicker method… 

 
Click on the chart styles 
button to the right of the chart 
to display a gallery of style 
options 

 
Ensure the Styles tab is 
selected, then click on Style 5 
to apply this style 

Notice this style overrides the 
Quick Layout applied 
previously  

 

4 

For Your Reference… 

To apply a chart style: 

1. Click on the chart 

2. Click on the Chart Tools: Design tab, click 
on the More arrow in the Chart Styles group 
and select a style, or 

 Click on the chart styles button and select a 
style 

Handy to Know… 

 You can save a chart as a template by right-
clicking on the chart and selecting Save as 
Template. You can then type a name in the 
Save Chart Template dialog box and click 
on [Save]. 

 Templates are listed under Templates in the 
Chart Type dialog box. 

5 
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UNDERSTANDING THE CHART FORMAT PANES 
 

 

 

 

 

 

The chart Format panes allow you to edit the 
elements of a chart with greater control than 
simply using the tools available on the Chart 
Tools tab. Currently the only downside is that 

Live Preview is not available with this feature. 
However as changes you make in the chart Format 
panes update live in the presentation, this is not too 
much of an inconvenience. 

Accessing Chart Format Panes 

There is a Format pane for every element in the Chart Elements 
menu (accessible via the chart elements button), as well as for some 
aspects of the chart not included in the Chart Elements menu such as 
the chart area. These Format panes contain advanced options for a 
particular chart element. 

You can access these Format panes using several different methods. 
You can access them via the chart elements button by pointing to the 
desired chart element until a black arrow appears, then clicking on the 
arrow and selecting More Options, as shown to the right. 

For instance, clicking on More Options for Chart Title will open the 
Format Chart Title pane, as shown below to the right. 

Alternatively, you can access the Format panes by clicking on the 
dialog box launchers on the Chart Tools: Format tab. Or you may 
choose to open a Format pane by selecting certain options from some 
of the menus on the Chart Tools: Format tab. For instance, if you 
click on Shape Outline in the Shape Styles group, point to Weight 
and select More Lines, a Format pane will open. 

When you choose to open a Format pane using these methods, the 
particular Format pane that opens will depend on what section of the 
chart is currently selected. 

Using The Chart Format Panes 

Though many of the options available in the Format panes are also 
available on the ribbon, there are many advantages to using the 
Format pane. For instance, many of the Format panes offer greater 
control over certain formatting options. One example is if you want to 
apply a gradient shape fill to your chart. Using the ribbon, you can 
select from a range of preset gradient options. However, using the 
Format pane, you can modify the gradient in a number of ways 
including deciding the type, direction, angle, transparency and 
brightness of the gradient. 

You can also move Format panes around the screen as required, by 
pointing to the top of the Format pane until a four-headed arrow 
appears then clicking and dragging it to wherever you require. This 
can be handy when you are working on a complex chart, or a number 
of charts and are going to be frequently using the formatting tools. 

Another advantage of using Format panes is that once one is open, 
you don’t have to close it in order to open another. You can open the 
specific Format panes for the other elements by simply double-
clicking on the desired element within the chart. For example, once the 
Format Chart Title pane is open, you can double-click on the plot 
area to open the Format Plot Area pane or double-click on the data 

labels to open the Format Data Labels pane etc. 
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FORMATTING CHART ELEMENTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can format individual chart elements such as 
the chart area, plot area, data series, axes, titles, 
data labels and legend. For example, you can 
format the text in a selected chart element using 

WordArt; applying a different style; or selecting a 
specific text fill, text outline or text effect. You can 
also apply other formatting options as desired. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or 
open the file Charts_6.pptx... 

 
On slide 2, click on the first 
data label (10) in the chart 

The other data labels for that 
series will also be selected… 

 
Click on the Home tab, then 
click on the drop arrow for 
Font Size in the Font group 
and select 10, then click on 
Bold 

 
Repeat steps 1 and 2 to 
reformat the other data labels 

 
Click on the chart plot area, 
then right-click to display a 
shortcut menu and select 
Format Plot Area to open 
the Format Plot Area pane 

 
Under Fill click on Gradient 
fill, then click on the drop 
arrow for Preset gradients 

 
Click on Light Gradient, 
Accent 2 to apply this 

 
Click on the slider for 
Brightness and drag it to the 
left until it reduces to 40% 

 
Close the Format Plot Area 
pane and view the result 

 

3 

6 7 

For Your Reference… 

To manually format chart elements: 

1. Click on the chart 

2. Click on the Chart Tools: Format tab 

3. Select the element to be formatted in Chart 
Elements in the Current Selection group 

4. Make the desired changes 

Handy to Know… 

 Grouped elements, such as data series and 
data labels, contain individual elements that 
can be selected after you’ve selected the 
group. For example, to select a single data 
label, select the series data labels from the 
chart element list or by clicking on one of the 
labels, then click on the required data label. 
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EDITING A DATA SERIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A big advantage of using an application like 
PowerPoint to make visual presentations of 
numeric data is that when the data changes you 
can easily reflect those changes in a PowerPoint 

chart. By displaying the underlying data, you can 
delete an unwanted data series using the standard 
Excel functions. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the 
previous file with this 
exercise, or open the file 
Charts_7.pptx... 

 
On slide 2, click on the 
chart to select it 

 
Click on the Chart Tools: 
Design tab then click on 
the bottom half of Edit 
Data in the Data group 

 
Select Edit Data to display 
the spreadsheet 

 
In the Canada column, edit 
the data as shown, then 
press  or click in 

another cell to apply the 
change 

Notice the chart updates 
automatically… 

 
Close the spreadsheet to 
view the changes in the 
chart 

 

3 

4 

5 

For Your Reference… 

To edit a data series: 

1. Select the chart, then click on the Chart 
Tools: Design tab 

2. Click on Edit Data in the Data group 

3. Edit the data as required 

Handy to Know… 

 If you want to add another data series to your 
chart, open the Excel worksheet and drag 
the blue line out to include however many 
additional columns you wish to add (each 
column is a data series). Then simply enter 
the data as required and the chart will update 
automatically. 
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HIDING DATA SERIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The data on which a chart is based is stored in 
an Excel worksheet. When you click on the Edit 
Data tool, the worksheet will open in Excel 
allowing you to modify it just like other Excel 

worksheets. To change chart data, simply click in 
the cell containing the data that you want to change 
and type the new information. PowerPoint will then 
update the chart to reflect the changes. 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Charts_8.pptx... 

 
On slide 2, ensure the chart is 
selected, then click on the 
chart filters button to display 
a fly-out menu of options 

 
Under Series, point to 
Canada – this greys out the 
other data series in the chart 
so you can clearly see the 
Canada data series 

Notice that an Edit Series 
button appears. Clicking on 
this button will open the Excel 
spreadsheet and an Edit 
Series dialog box. 

Let’s hide the Canada data 
series… 

 
Click on the checkbox for 
Canada so it appears without 
a tick, then click on [Apply] to 
apply this change and close 
the fly out-menu of options 

The bars representing the 
Canada data series no longer 
appear in the chart… 

 
Repeat step 1, then click on 
the checkbox for Canada so it 
appears with a tick and click 
on [Apply] so that the data 
series is shown in the chart 
again 

 

1 

For Your Reference… 

To filter data: 

1. Select the chart 

2. Click on the chart filters button 

3. Select the Series or Categories you wish to 
hide/show and click on [Apply] 

3 

Handy to Know… 

 You can click on NAMES at the top of the 
chart filters fly-out menu to specify whether 
you want the names for the series and 
categories displayed. 
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WORKING WITH PIE CHARTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pie charts are one of the best ways to graphically 
represent a single series of data. You can do 
some pretty fancy things with pie charts, 
especially 3-D pie charts. For example, you can 

move various pie wedges, or slices, around the 
screen individually placing them for emphasis. You 
can explode the chart to show individual portions 
and rotate it to place a slice in a specific position. 

Try This Yourself: 

S
a

m
e

 

F
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e
 

Continue using the 
previous file with this 
exercise, or open the file 
Charts_9.pptx... 

 
On slide 3, click on a pie 
slice to select the chart 

 
Click on the US pie slice 
to select it only 

 
Click on the Chart Tools: 
Format tab, then click on 
Shape Fill in the Shape 
Styles group and select 
Dark Red, Accent 6, 
Darker 50%, as shown 

 
Click off the chart, then 
click on a pie slice to 
select all slices of the pie 
chart 

 
Right-click on a pie slice 
to display a shortcut menu 
and select Format Data 
Series to display the 
Format Data Series pane 

 
Drag the Angle of first 
slice slider to see how the 
chart rotates, then set it to 
195° 

 
Drag the Pie Explosion 
slider to see how the 
slices move, then set it to 
18 and close the Format 
Data Series pane 

 

2 

3 

5 

For Your Reference… 

To rotate a pie chart: 

1. Click on the chart 

2. Right-click on the chart to display a shortcut 
menu and select Format Data Series 

3. Change the Angle of first slice 

7 

Handy to Know… 

 An exploded pie chart (that is, one in which 
the wedges are displayed apart from each 
other) can be easily re-joined by displaying 
the Format Data Series pane and setting 
the Pie Explosion to 0%. 
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CHAPTER 3 TABLES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 learn how to insert tables and add table data 

 learn how to insert rows and columns 

 learn how to apply a table style 

 learn how to merge and split cells 

 learn how to adjust column widths 

 learn how to adjust row height 

 learn how to resize and reposition a table 

 learn how to format table data 

 learn how to align table data 

 learn how to apply borders to a table 

 learn how to apply shading to a table. 

Tables are used to present data or other information in a structured, 
grid-like format. Tables are ideal for presenting rows and columns 
of data in graphical form, as tables add can add visual interest to 
otherwise dull data. 

In PowerPoint, you can create and insert pre-formatted tables, so all 
you really need to do is type in the table data. Having said that, 
PowerPoint also offers an almost endless range of formatting 
options so you can customise the table to suit your needs. 

INFOCUS 
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INSERTING A TABLE USING THE RIBBON 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tables are often used to present data in a 
structured and graphical framework. Using a 
table makes entering data quick and easy. 
Tables are inserted into special placeholders, 

with the number of rows and columns that you 
have specified. The intersection of a row and 
column is called a cell, which is where you enter 
your data.  

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this 

exercise you MUST open 
the file Tables_1.pptx… 

 
Click on slide 2 to display 
it in the Slide window 

 
Click on the Insert tab, 
then click on Table in the 
Tables group to display a 
menu of options 

 
Select Insert Table to 
open the Insert Table 
dialog box 

 
Ensure 5 is selected in 
Number of columns, 
press , then type 5 for 

Number of rows and 
click on [OK] 

A blank table will be 
inserted onto the slide 
with the cursor in the first 
cell so you can start 
typing… 

 
Click in the second cell, 
then enter the data as 
shown, pressing  to 

move to the next cell, or 
pressing  +  to 

move back to the previous 
cell if required 

 

2 

4 

5 

For Your Reference… 

To insert a table: 

1. Click on the Insert tab, then click on Table in 
the Tables group 

2. Select Insert Table 

3. Type the Number of columns, press , 

type the Number of rows, then click on [OK] 

Handy to Know… 

 You can select Draw Table from the Table 
menu on the Insert tab to draw a table 
freehand, or select Excel Spreadsheet to 
use a table from Excel. 
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INSERTING ROWS AND COLUMNS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

As you work with a table and add data, you may 
find that you need extra rows and columns. 
Rows and columns can be inserted anywhere in 
the table, depending on where you have 

positioned the cursor. For example, rows can be 
inserted above or below the current (active) row, 
and columns can be inserted to the left or the right 
of the current (active) column. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Tables_2.pptx... 

 
On slide 2, click in the first cell 
of the table to make it active 

Let’s insert a row above so we 
can create a heading … 

 
Click on the Table Tools: 
Layout tab, then click on 
Insert Above in the Rows & 
Columns group 

A row will be inserted above 
the active row… 

 
Type First Quarter Sales into 
the new row, as shown 

Let’s insert a column… 

 
Click anywhere in the text 
Germany, then click on Insert 
Right in the Rows & 
Columns group to insert a 
column to the right of the 
active column 

 
Click in the empty cell next to 
Germany and type Canada, 
press  and type the data as 

shown, pressing  to move 

down the column 

 

1 

3 

4 

5 

For Your Reference… 

To insert rows and columns: 

1. Click in a column or row to make it active 

2. Click on the Table Tools: Layout tab and 
select an option from the Rows & Columns 
group 

Handy to Know… 

 To delete a row or column, click in the row or 
column to delete, click on the Table Tools: 
Layout tab, then click on Delete in the Rows 
& Columns group and select Delete 
Columns or Delete Rows. 

 You can right-click in a cell and use the mini 
toolbar to insert or delete rows or columns. 
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APPLYING A TABLE STYLE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you insert a table onto a slide, the table will 
be formatted with a table style. This table style, 
which includes colours and fonts, will reflect the 
applied theme if applicable. If you’re not entirely 

convinced that Microsoft have applied a 
complementary table style to suit the presentation, 
you can apply a different table style to better suit 
your needs. 

Try This Yourself: 

S
a

m
e

 

F
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e
 

Continue using the previous 
file with this exercise, or 
open the file 
Tables_3.pptx... 

 
On slide 2, click in the table 
to activate the placeholder, if 
required 

The table is now able to be 
edited, and you can make 
formatting and textual 
changes to the table as 
required… 

 
Click on the Table Tools: 
Design tab, then click on 
the More arrow for the 
Table Styles gallery in the 
Table Styles group to 
display a gallery of options 

The currently applied style is 
highlighted with an orange 
border. The gallery displays 
table styles that are the Best 
Match for Document, as well 
as many other table styles… 

 
Point to the various table 
styles to see them applied 
temporarily to the table in 
Live Preview 

 
Under Medium, select 
Medium Style 4 – Accent 1 
to apply this style to the 
table 

 

2 

3 

4 

For Your Reference… 

To apply a table style: 

1. Click in the table, then click on the Table 
Tools: Design tab 

2. Click on the More arrow for the Table Styles 
gallery, in the Table Styles group, and select 
an option 

Handy to Know… 

 Once you have applied a table style, you can 
further customise the table by working with 
the Shading, Borders and Effects tools on 
the Table Styles group. Note you can apply 
borders and shading to selected cells but 
effects will be applied to the entire table. 
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MERGING AND SPLITTING CELLS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If the default grid-like layout of your table does 
not suit your requirements, you can merge and 
split existing cells. To merge cells is to select two 
or more cells and merge them to form a single 

cell. To split cells is to select a cell and then split 
the cell into two or more cells. Cells will be split 
within the original cell, so it won’t affect the overall 
table structure. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the 
file Tables_4.pptx... 

 
On slide 2, click anywhere in 
the Total row of the table, to 
make the row active 

 
Click on the Table Tools: 
Layout tab and click on Split 
Cells in the Merge group to 
open the Split Cells dialog box 

 
Ensure that the Number of 
columns is 2 and the Number 
of rows is 1, then click on [OK] 

The Total cell is now two cells. 
The word Total no longer fits on 
one line but we will learn later 
on how to change this… 

 
Click in the empty cell next to 
Total and type (N), then click 
outside the table to view the 
result 

Let’s merge six cells to form a 
single cell…. 

 
Point to the outside of the left 
border of the first row until a 
black arrow appears, as shown 

 
Click once to select the entire 
row, then click on the Table 
Tools: Layout tab and click on 
Merge Cells in the Merge 
group 

 
Click outside the table to 
deselect it and view the result 

 

2 

4 
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For Your Reference… 

To merge cells: 

1. Select the row, column or cells to merge, 
then click the Table Tools: Layout tab and 
click on Merge Cells in the Merge group 

To split cells: 

1. Click on the Table Tools: Layout tab and 
click on Split Cells in the Merge group  

Handy to Know… 

 To select multiple cells, click in the first cell 
that you want to select and drag across or 
down to select multiple cells, then release 
the mouse button. You can then merge the 
selected cells. You can also apply formatting 
and the like to the selected cells. 

6 

7 
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ADJUSTING COLUMN WIDTHS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you create a table in PowerPoint, all 
columns are of equal width. As you insert and 
format text, such as increasing the font size, the 
column width adjusts to fit the text - for the most 

part. However sometimes you may find that you 
need to make manual adjustments to your columns 
to better fit the text. You can also ensure even 
distribution of columns within the table. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the 
file Tables_5.pptx... 

 
On slide 2, click anywhere in the 
table to make it active 

Let’s manually resize the 
Switzerland column to make the 
heading fit on one line… 

 
Point to the border between 
Switzerland and Germany until 
the double-headed arrow 
appears as shown 

 
Hold down the left mouse button 
until a vertical dashed line 
appears, then drag to the right 
slightly to resize the column 

The heading should now fit. 
Let’s resize the columns more 
accurately… 

 
Click and drag to select the 
columns from U.S to Canada 

 
Click on the Table Tools: 
Layout tab then click on 
Distribute Columns in the Cell 
Size group 

PowerPoint will distribute the 
width of the selected columns 
equally between them – in this 
case, Switzerland once again 
doesn’t fit. We will re-adjust this 
column width in another 
exercise 

 

2 

3 
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For Your Reference… 

To adjust column widths: 

 Click and drag the column border to the left 
or right, or 

 Select the table, click on the Table Tools: 
Layout tab, then click on Distribute 
Columns in the Cell Size group 

Handy to Know… 

 You can auto-fit individual columns in a table 
by pointing to the column borders and then 
double-clicking to resize the column. 

 You can specify a column size by clicking on 
the Table Tools: Layout tab and adjusting 
Width in the Cell Size group. 

5 
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ADJUSTING ROW HEIGHTS 
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When you create tables in PowerPoint, the height 
of each row will depend on the applied table 
style, as well as the size of the font applied to the 
table cells. If you increase the font size, for 

example, the row height will increase accordingly. 
However, you may want to increase the row height 
so that data in the row stands out, for example, or 
so that the data is better aligned within the cell. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file 
Tables_6.pptx... 

 
On slide 2, click anywhere 
in the table to make it active 

 
Point to the border between 
the Exports and Imports 
rows until the pointer 
appears as a double-
headed arrow 

Let’s manually resize the 
row… 

 
Hold down the left mouse 
button until a horizontal 
dashed line appears, then 
drag down, as shown, to 
resize the Exports row 

Let’s resize the rows more 
accurately…  

 
Click on the Table Tools: 
Layout tab and click on 
Distribute Rows in the Cell 
Size group 

The table is now too long 
and we need to resize it, but 
we’ll learn more about that 
in the next exercise 

 

2 

3 

For Your Reference… 

To adjust row heights: 

1. Click and drag the row border up or down, or 

 Select the column, then specify the Height in 
the Cell Size group on the Table Tools: 

Layout tab 

Handy to Know… 

 You can specify a row size by selecting the 
row, clicking on the Table Tools: Layout tab 

and adjusting Width in the Cell Size group. 

4 
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RESIZING AND POSITIONING A TABLE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you insert a table, add data, insert 
columns, rows and the like, you may find that the 
table is too big, or the column widths are wider 
than necessary. It is easy to resize a table by 

dragging on a placeholder border. Once resized, 
you may need to reposition the table so that it sits 
centred on the slide, or in the desired position.  

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the 
previous file with this 
exercise, or open the file 
Tables_7.pptx... 

 
Click anywhere in the 
table to display the 
placeholder border 

 
Point to the middle control 
handle of the left border 
until the pointer changes 
to a double-headed arrow 

 
Click and drag to the left, 
as shown, then release 
the mouse to resize the 
table 

Total and Switzerland now 
each fit on a single line… 

 
Point to the bottom control 
handle until a double-
headed arrow appears, 
then drag down as shown, 
and release the mouse to 
resize the table 

Now that we have resized 
the table, let’s reposition 
it… 

 
Point to any part of the 
outside border until a four-
headed arrow appears, 
then click and drag down 
to reposition the table on 
the slide as shown 
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For Your Reference… 

To resize a table: 

1. Click and drag on a placeholder border 
handle, as required 

To reposition a table: 

1. Click in the table, then click and drag the 
placeholder border, as required 

5 

Handy to Know… 

 You can use the Table Tools: Layout tab to 
align the table to a specific point on the slide. 
For instance you can choose to align centre 
or align left etc. To do so, click on the Table 
Tools: Layout tab, then click on Align in the 
Arrange group and select an option. 
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FORMATTING TABLE DATA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can format table data in the same way as 
you format text on slides. You can use any of the 
tools in the Font and Paragraph groups on the 
Home tab to format table data. Before you can 

apply formatting, however, you first need to select 
the cells that contain the text you want to format. 
Here you will apply a range of basic font formatting 
to selected text. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the file 
Tables_8.pptx... 

 
On slide 2, point to the left of the 
first row of the table, until the 
pointer is a black horizontal 
arrow, then click to select the row 

Let’s increase the font size… 

 
Click on the Home tab, then click 
on the drop arrow for Font Size 
in the Font group and select 28 

 
Ensure row 1 is still selected, 
then click on Italic in the Font 
group to apply italics to the text 

 
Click in the first cell in row 3, 
press and hold  and click 

after 19 (last cell, row 5) to select 
the three rows, then click on 
Decrease Font Size in the Font 
group to reduce the font size to 
16 pt 

Let’s apply automatic formatting 
to the Total row… 

 
Click anywhere in the Total row, 
then click on the Table Tools: 
Design tab and click on Total 
Row in the Table Style Options 
group until it appears with a tick 

The Total row is now the same 
colour as the heading row and so 
stands out from the other rows 

 

3 

4 

For Your Reference… 

To format table data: 

1. Select the row, column or cells that contain 
the text you want to format 

2. Click on the Home tab, then click on the 
required formatting tools in the Font and 
Paragraph groups 

5 

Handy to Know… 

 You can use the Select tool to select rows or 
columns. To do this, click anywhere in the 
desired row or column, click on the Table 
Tools: Layout tab, click on Select in the 
Table group and click on Select Column or 

Select Row. 
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ALIGNING TABLE DATA 
 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

It is important to ensure that your table data is 
lined up. The audience must be able to see which 
data belongs to which column or row. Although 
there’s a range of alignment tools in the 

Paragraph group, it’s best to work with the 
alignment tools on the Table Tools: Layout tab 
when aligning data in tables. Data can be aligned 
horizontally or vertically within a cell. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or 
open the file Tables_9.pptx... 

 
On slide 2, click on the table 
placeholder to select it 

First we’ll align all data 
vertically in the table… 

 
Click on the Table Tools: 
Layout tab, then click on 
Centre Vertically in the 
Alignment group to vertically 
centre all of the text in the 
table 

Now we’ll centre some of the 
data so that it lines up with 
the column headings… 

 
Click in the cell titled U.S, 
then press and hold  and 

click in the last cell (65) to 
select all cells in between, as 
shown 

 
Click on the Table Tools: 
Layout tab, then click on 
Centre in the Alignment 
group to centre the data in 
these cells – click outside the 
table to view the result 
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For Your Reference… 

To align table data: 

1. Select the cells with the data to align 

2. Click on the Table Tools: Layout tab 

3. Select one of the alignment options in the 
Alignment group 

Handy to Know… 

 The Text Direction tool is another useful tool 
in the Alignment group. Using this tool you 
can rotate selected text to 90° or 270˚, or you 
can select to stack characters on top of one 
another. Changing text direction might be 
required when the text doesn’t fit the column, 
but the column cannot be adjusted. 
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APPLYING BORDERS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The borders that appear applied to a table will 
depend on the table style that you have applied. 
If you have applied a table style that you like but 
it doesn’t have the required borders, you can 

easily add borders of various widths and colours to 
suit your needs. To apply borders, you must first 
select the area to apply the borders to, such as the 
table, row(s), column(s) or cell(s).  

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Tables_10.pptx... 

 
On slide 2, select the table, 
then click on the Table Tools: 
Design tab, click on the drop 
arrow for Pen Style in the 
Draw Borders group and 
select the 3rd border option 
(dotted line) 

The pointer will change to a 
pen… 

 
Click on the drop arrow for 
Pen Weight in the Draw 
Borders group and select 3 pt 

 
Click on Pen Colour in the 
Draw Borders group and click 
on Black 

 
Point to the top of the left 
border for the U.S column, 
then click and drag down to 
the bottom of the column to 
draw the border as shown 

 
Press  until the pointer 

changes back to normal, then 
select all columns and rows 
beneath the heading 

 
Click on the drop arrow for 
Borders in the Table Styles 
group and select Inside 
Borders, then click outside 
the table to view the result 

 

1 

4 

For Your Reference… 

To apply borders to a table: 

1. Select the required row, column or cell, then 
click on the Table Tools: Design tab 

2. Select options from the Draw Borders group 

3. Draw borders using your pointer, or 

 Click on Borders in the Table Styles group 
and select an option 

Handy to Know… 

 To remove borders from a table, select the 
table, row, column or cells that contain the 
border(s) you want to remove, click on the 
Table Tools: Design tab, then click on 
Borders in the Table Styles group and 

select No Border. 

6 
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APPLYING SHADING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Shading is often used in a table to make 
important data stand out, such as headings or 
figures. As with borders, the shading, or fill 
colour that is applied to your table will depend on 

the table style you have applied. PowerPoint 
provides a range of shading options, which include 
solid colours, as well as gradient fills. Shading can 
be applied or removed to suit your needs. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Tables_11.pptx... 

 
On slide 2, point to the left of 
the second row of the table, 
until a black horizontal arrow 
appears, then click to select 
the row 

 
Click on the Table Tools: 
Design tab, then click on the 
drop arrow for Shading in 
the Table Styles group to 
display the colour palette 

 
Point to various colours to 
see them applied temporarily 
in Live Preview 

 
Click on Lime, Accent 1, 
Darker, 25% to apply this 
colour, then click outside the 
table to view the result 

Let’s apply a gradient to the 
Total row… 

 
Repeat steps 1 to 4 to apply 
the same shading to the 
Total row 

 
With the Total row selected, 
click on the drop arrow for 
Shading in the Table Styles 
group, then point to Gradient 
and click on Linear Up in 
Dark Variations 

 

1 

4 

For Your Reference… 

To apply shading to a table: 

1. Select the table, row, column or cells that 
you want to apply shading to 

2. Click on the Table Tools: Design tab, then 
click on Shading in the Table Styles group 
and select a shading option 

6 

Handy to Know… 

 To remove shading from a table, select the 
table, row, column or cells that contain the 
shading you want to remove, click on the 
Table Tools: Design tab, then click on 
Shading in the Table Styles group and 

select No Fill. 
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CHAPTER 4 IMPORTING INTO POWERPOINT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of the differences between linked 
and embedded objects 

 learn how to copy a Word table as an embedded object 

 learn how to insert a new Excel table as an embedded 
object 

 learn how to copy and link an Excel table 

 learn how to copy and link Excel charts. 

The information conveyed in presentations is often sourced from 
other files, such as Microsoft Word documents or Microsoft Excel 
spreadsheets. The overall advantage of importing information is that 
you save time, avoid accidental errors, and you can create dynamic 
files that automatically reflect any changes made to their source.  

INFOCUS 
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UNDERSTANDING OBJECT LINKING AND EMBEDDING 
 

 

 

 

  

 

You can use Object Linking and Embedding 
(OLE) to include content from other programs 
that support OLE – such as Excel, Word or 
Outlook – in Microsoft PowerPoint. For instance, 

you can insert an Excel worksheet in a PowerPoint 
presentation. To see which programs support OLE, 
click on the Insert tab, then click on Object in the 
Text group to display the Insert Object dialog box.  

Linked And Embedded Objects 

When you copy information between Word and PowerPoint, or any other program that supports OLE, 
you can copy the information as either a linked object or an embedded object. 

Linked Objects 

Linked objects are created in a source file and are inserted in the destination file while maintaining a 
connection between the two files. With a linked object, the original information remains stored in the 
source file. The destination file stores the location of the original data and displays a representation of 
the linked information. The linked object in the destination file can be updated when the source file is 
updated.  

Embedded Objects 

The information (or object) from a source file is inserted into a destination file. Once embedded, the 
object becomes part of the destination file. There is no connection to the source file so any changes 
made to the original file will not update the embedded object. Because embedded objects are stored in 
the destination document, the file size of the destination document is larger than if you were to link the 
same information. 

When To Use Linked Objects Versus Embedded Objects 

Use linked objects when you want the information in your destination file to be updated when the data 
in the source file changes. The source file must remain available on your computer or network to 
maintain the link to the original data. 

Use an embedded object when you don't want the copied data to be updated when changes are made 
to the source file. The version of the source is embedded entirely in the presentation. When the 
presentation is opened on another computer, the embedded object can be viewed without having access 
to the original data.  

A linked object is linked to the source file 

An embedded object has no connection to the source file 

Source file updates the linked object 
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COPYING WORD TABLES AS EMBEDDED OBJECTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Microsoft Office makes it easy to reuse tables 
from both Word and Excel in a PowerPoint 
presentation. You simply select the table (or cell 
range in Excel), copy it and paste it into 

PowerPoint as an embedded object using Paste 
Special. By double-clicking on the embedded table 
you can edit it, as desired, in the application in 
which it was created.  

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise you 

MUST open the file 
Importing_1.pptx… 

 
Launch Word 2016, then open 
Importing Word Table.docx in 
the course files folder 

 
Click in the table, click on the 
Select Table icon above the table 
to select, then press  +  to 

copy the table to the clipboard. 
Close Word 

 
In PowerPoint, click on Slide 2, 
then click on the bottom half of 
Paste on the Home tab and 
select Paste Special to open the 
Paste Special dialog box 

 
Click on Microsoft Word 
Document Object in As, then 
click on [OK] 

 
Move the object to the left, then 
drag a corner to the right to 
increase the size of the text 

 
Double-click on the object to open 
Word within PowerPoint, click on 
the Table Tools: Design tab, 
then click on Table Grid 4 – 
Accent 6 in Table Style 

 
Drag the column guides to make 
each column a little narrower, 
centre the content vertically in the 
rows (Table Tools: Layout tab), 
then click outside the table twice 
to view the result  

 

3 

4 

For Your Reference… 

To copy a table from Word: 

1. Select the table in Word, then click on Copy 
in the Clipboard group 

2. Click on the slide in PowerPoint 

3. Click on the bottom half of Paste and select 
Paste Special 

4. Click on Microsoft Word Document Object 

Handy to Know… 

 You can insert an entire file (both Word and 
Excel) as an embedded object. Click on the 
Insert tab, then click on Object in the Text 
group on to display the Insert Object dialog 
box. Click on Create from file and then 

[Browse] to the file. 

7 
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INSERTING A NEW EXCEL TABLE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the 
file Importing_2.pptx... 

 
Click on Slide 3, then click on 
the Insert tab 

 
Click on Table in the Tables 
group and select Excel 
Spreadsheet 

After a moment, a miniature 
copy of Excel will open in 
PowerPoint complete with the 
full Excel ribbon... 

 
Type the details as shown into 
the worksheet – you will need 
to drag to expand the 
worksheet 

 
Click in cell B6, click on Sum in 
the Editing group, then press 

 to insert a formula that 

adds the values above the cell 

 
Format the table as: 

Cell ranges A1 – C1 and A6 – 
C6: Heading 4, Accent 6 
(Styles group), 26pt, bold 

A2 – C5: 20pt 

Adjust the column widths to 
approximately fit the text 

 
Drag to reduce the size of the 
spreadsheet until it just fits the 
data, click outside the 
spreadsheet twice to see the 
result 

 

For Your Reference… 

To insert a new Excel table: 

1. Click in the slide 

2. Click on the Insert tab, then click on Table in 
the Tables group and select Excel 
Spreadsheet 

3. Enter the text as desired, then click outside 
the table to close Excel 

You can create a new Excel 2016 table in a 
PowerPoint presentation to take advantage of the 
functionality of Excel tables, such as their 
formulas and so on. The table will be inserted as 

an embedded object. This means that you cannot 
edit the table using the options in PowerPoint, but 
instead you can edit it in Excel which will open 
within PowerPoint.   

Category Number Percentage 

Personal 26,700 25% 

Public 42,420 40% 

Freight 36,700 35% 

   

Total   

 
4 

1 

5 

Handy to Know… 

 To edit the Excel table after you have clicked 
outside it, double-click on the embedded 
object to open the worksheet in Excel. 

 To insert a new Word embedded object, 
click on the Insert tab, click on Object in the 
Text group, click on Create new, then click 
on Microsoft Word document. 
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COPYING AND LINKING EXCEL TABLES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the 
file Importing_3.pptx... 

 
Launch Microsoft Excel 2016, 
then open Importing Excel 
Table.xlsx in the course files 
folder 

 
Click in cell A1, hold  and 
click in cell C5 to select the table 

 
Press  +  to copy the table 

Leave Excel open so that the link 
will be able to be created… 

 
In PowerPoint, click on Slide 4, 
click on the bottom half of Paste 
on the Home tab, then select 
Paste Special to display the 
Paste Special dialog box 

 
Click on Paste link, then click on 
[OK] to insert the table as a 
linked Excel worksheet object – 
let’s check that the link works 

 
Double-click on the table to open 
Excel, change the Theme to 
Facet (Page Layout tab), 
change the font colour for cell 
range A2:C4 to Dark Green 
Accent 2, and format cell range 
A2:A4 as Bold. Close Excel 
saving the file 

 
In PowerPoint, drag a corner 
handle to increase the size of the 
table, then click outside the 
linked object to view the result 

 

For Your Reference… 

To copy and link an Excel table: 

1. Copy the cells to the clipboard in Excel 

2. Click on the slide in PowerPoint 

3. Click on the bottom half of Paste, then select 
Paste Special 

4. Click on Paste link, then click on [OK] 

Rather than pasting a copy of an Excel table in a 
slide, you can link the table to the source Excel 
worksheet during the pasting process. The\is will 
insert the table as a linked object. When you 

open the presentation, the link will be updated to 
reflect any changes that have been made to the 
Excel file. You can also open Excel directly from 
the object to update both tables simultaneously.  

1 

5 

Handy to Know… 

 You cannot use PowerPoint options to edit a 
linked object. You must double-click on it to 
edit it in the source application. 

 If your changes don’t appear immediately in 
the linked object, right-click on the object and 

select Update Link. 

7 
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COPYING AND LINKING EXCEL CHARTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the file 
Importing_4.pptx... 

 
Launch Microsoft Excel 2016 and 
open the file Importing 
Charts.xlsx in the course files 
folder 

 
Click on the border of the chart to 
select it 

 
Press  +  to copy it to the 

clipboard, then close Excel 

 
In PowerPoint, click on Slide 5, 
press  +  to paste the 

chart, then drag to make it larger 

The colours of the data series 
alter to conform with the 
presentation’s theme, but the 
chart area hasn’t... 

 
Click on the Chart Tools: 
Format tab, select the blue 
Chart Area and change the 
Shape Fill to Dark Green, 
Accent 2, Lighter 80% (row 2, 
col 6) 

Let’s edit the data... 

 
Click on the Chart Tools: 
Design tab, then click on Edit 
Data to open the source file in 
Excel 

 
Type 10 in cell B6, press , 

then close Excel saving the file – 
the Australian slice is now larger 
and the other pieces have moved 
to accommodate the change 

 

For Your Reference… 

To copy and link an Excel chart: 

1. Select the chart in Excel 

2. Click on Copy in the Clipboard group 

3. Click on the slide in PowerPoint 

4. Click on Paste 

When you copy a chart from Excel and paste it 
into your presentation, the chart is linked 
automatically to the data in the external Excel 
worksheet – that is, the chart is inserted as a 

linked object. To change the chart in PowerPoint, 
you must change the source worksheet in Excel. 
The Excel worksheet and chart is a separate file – 
it is not saved with the PowerPoint presentation. 

2 

4 

Handy to Know… 

 When you create a chart in PowerPoint 
using, for instance, the Insert Chart icon, the 
Excel worksheet is saved with the 
PowerPoint file – that is, the Excel chart is 
embedded in your presentation. 

7 
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CHAPTER 5 ENHANCING IMAGES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of picture enhancements 

 gain an understanding of the Format Picture pane 

 learn how to remove the background of an image 

 learn how to apply colour corrections to an image 

 learn how to recolour an image 

 learn how to apply a picture style to an image 

 learn how to apply effects to an image 

 learn how to apply artistic effects to an image 

 learn how to crop an image. 

Like other Microsoft applications such as Word and Excel, 
PowerPoint comes complete with a range of tools that let you edit 
images inserted on a slide. The range of tools is so comprehensive 
that it has all but eliminated the need to use third-party image-
editing software. 

INFOCUS 
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UNDERSTANDING PICTURE ENHANCEMENTS 
 

 

 

 

 

 

PowerPoint provides you with an array of tools on 
the Picture Tools: Format tab that you can use 
to enhance pictures in your documents. You can 
adjust pictures by correcting, recolouring and 

applying artistic effects, or you can work with the 
picture border and apply styles, borders and 
effects. You may never need to use third-party 
image-editing software again. 

Adjust Group 

By using the tools in the Adjust group on the Picture Tools: Format tab (as shown above), you can 
remove the background of a picture and apply corrections, such as sharpening or softening the 
picture or adjusting the contrast and brightness (to lighten or darken the picture). You can also colour 
the picture by adjusting the saturation, tone or colour. If this range of enhancement options doesn’t 
quite add the flair you’re after, you can also apply a range of artistic effects, such as a glass, photocopy 
or paint strokes. You can also compress a picture to reduce its size, change the picture to swap the 
current image with a different one but still retain the size and formatting, or reset the picture to revert 
the image to its original unformatted state. 

Picture Styles Group 

While the tools in the Adjust group of the Picture Tools: Format tab are designed to enhance the 
picture itself, the tools in the Picture Styles group are used to work with the border or frame of the 
picture. 

You can apply styles, borders and effects to picture borders to further enhance your pictures. Choose 
a style from the Picture Style gallery, add a coloured picture border or apply a picture effect to the 
border, such as a shadow, glow or reflection. 

Arrange Group 

When you insert pictures on a slide, they adopt a stacking order whereby the first image is at the bottom 
of the stack. If images overlap, the more recently added image(s) will partly obscure those images added 
before them. Using the commands in the Arrange group (as shown above) you can adjust the stacking 
order of overlapping pictures by bringing them forward or sending them back. You can also align and 
rotate your pictures. 

Size Group 

This group allows you to crop your picture to eliminate certain parts of the picture you may not want or 
to simply increase or reduce the size of the picture. 

Clip Art 

You can also use the Picture Tools: Format tab to edit and enhance clip art images. 

This is the left half of the ribbon displaying 
the Adjust and Picture Styles groups on the 
Picture Tools: Format tab. 

This is the right half of the ribbon 
displaying the Arrange and Size groups 
on the Picture Tools: Format tab. 
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THE FORMAT PICTURE PANE 
 

 

 

 

 

 

The Format Picture pane allows you to edit 
pictures easily by grouping all picture commands 
in one easy to access location. Though many of 
the editing options are also available on the 

ribbon, the Format pane provides greater control 
over the edits you make. The fact that you can 
move the pane around the screen using the options 
in the top right corner is also quite handy. 

The Format Picture Pane 

You can access the Format Picture pane via a number of different methods. You can right-click on an 
image to display the shortcut menu from which you select Format Picture. Alternatively, you can click 
on the Picture Styles dialog box launcher on the Picture Tools Format tab or select Options from the 
bottom of various galleries such as the Picture Effects or Colour galleries. 

Once open, you can use the Format Picture pane to perform any of the functions you would normally 
use the Picture Tools: Format tab for, because the Format Picture pane contains the same tools. 
However, as well as providing access to the galleries of preset options, the Format Picture pane also 
includes additional tools. These tools let you manually and accurately further adjust options. 

The Format Picture pane is divided into four categories – each of which is accessed by clicking on its 
icon beneath the heading. Once a category is selected, the various subcategories will display in the 
pane. To see the available tools, expand the subcategories by clicking on the arrow to the left. 

1 2 3 

 
Fill & Line Fill & Line allows you to add a fill to your picture or add a line border. Depending on 

what sort of fill you choose (solid, gradient, picture, texture or pattern) determines 
the options you are provided with. The same goes for line – you can choose no line, 
solid line or gradient line and each option comes with a range of settings to choose 
from. 

 
Effects You can see in the corresponding image that Effects lists the Picture Effects from 

the Picture Styles group on the Picture Tools: Format tab, as well as Artistic 
Effects from the Adjust group. However, greater control and accuracy is possible 
here, for example, you can choose to apply the reflection preset effect to your 
picture then adjust the transparency, size, blur and distance to suit your 
requirements. 

 
Size & 
Properties 

Size & Properties allows you to manipulate the size of images and text boxes and to 
determine their position on the slide. You can also add a title and description to a 
picture. 

 
Picture Picture contains commands from the Adjust and Size groups on the Picture Tools: 

Format tab. Picture Corrections and Picture Colours contain the same features as 
those on the ribbon, however they also contain additional features such as slider bars 
for settings like sharpness, brightness, contrast and saturation. 

 

4 
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REMOVING AN IMAGE BACKGROUND 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sometimes when you insert images you will find 
that the image contains a background that does 
not complement the colours used in the 
presentation. This is common when inserting 

images with a white background onto a slide that 
contains a coloured background. PowerPoint’s 
Remove Background tool will remove any 
background and only the actual image remains. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file 
Enhancing Images_1.pptx... 

 
Navigate to and display slide 
3 in the Slide window, then 
click on the image to select it 

 
Click on the Picture Tools: 
Format tab, then click on 
Remove Background in the 
Adjust group 

The pink area represents the 
background to be discarded, 
while the placeholder box 
determines what you will end 
up with if you accept the 
changes. Let’s increase the 
placeholder to include more of 
the image… 

 
Pull the side handles of the 
placeholder out to the edges, 
as shown, to increase the 
amount of branch that is kept 

 
Click on Keep Changes in 
the Close group of the 
Background Removal tab to 
accept the changes 

The white background is now 
removed… 

 
Reposition the image so it is 
not overlapping the text, then 
deselect it to view the result 

 

2 

3 

For Your Reference… 

To remove the background of an image: 

1. Click on the image to select it 

2. Click on the Picture Tools: Format tab, then 
click on Remove Background 

3. Adjust the image area if required 

4. Click on Keep Changes 

Handy to Know… 

 When removing the background of an image, 
you can select areas to include or exclude 
using the Mark Areas to Keep and Mark 
Areas to Remove tools on the Background 
Removal tab. Select the relevant tool, then 
click and drag on areas of the image to 
include or exclude. 

5 
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APPLYING COLOUR CORRECTIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can apply colour corrections to images, 
particularly photos, to improve the look of the 
image. Where the image is too dark, for example, 
you can increase the brightness and contrast to 

lighten the image. Or, you can enhance the detail in 
an image by sharpening it. To reduce detail in an 
image, you can apply softening. You can correct 
images using the Correction tool. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the 
file Enhancing Images_2.pptx... 

 
Click on slide 2 to display it in 
the Slide window, then click on 
the image to select it 

Let’s sharpen this image… 

 
Click on the Picture Tools: 
Format tab, then click on 
Corrections in the Adjust group 
to display the Corrections 
gallery 

Here you can select from a 
range of correction options. The 
highlighted options indicate the 
settings currently applied to the 
image… 

 
Move the mouse pointer over 
some of the correction options to 
view the result on the image in 
Live Preview 

 
Click on Sharpen: 50% under 
Sharpen and Soften to apply 
this correction 

You will notice the image has 
become slightly sharper. Let’s 
now increase the contrast… 

 
Click on Corrections to display 
the Corrections gallery, then 
click on Brightness: 0% 
(Normal) Contrast: +20% 
(column 3, row 4) under 
Brightness and Contrast to 
apply this correction 

 

1 

3 

For Your Reference… 

To apply colour corrections to an image: 

1. Click on the image to select it 

2. Click on the Picture Tools: Format tab, then 
click on Corrections in the Adjust group 

3. Click on a correction option to apply it 

Handy to Know… 

 You can specify an exact percentage to 
increase or reduce brightness and contrast of 
an image, or to sharpen or soften the image. 
Simply click on Corrections on the Picture 
Tools: Format tab and select Picture 
Correction Options to open the Format 

Picture pane. 

5 
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RECOLOURING AN IMAGE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A common image-editing task is to recolour an 
image. In PowerPoint, you can recolour an image 
by adjusting the saturation of the image. The 
more saturated an image, the more vivid the 

colours. You can also adjust the tone or 
‘temperature’ of an image, which means to include 
or exclude more blue or orange. Or, you can simply 
apply a colour to your image to recolour it. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the 
file Enhancing Images_3.pptx... 

 
Click on slide 3 to display it in 
the Slide window, then click on 
the image to select it 

Let’s reduce the tone of the 
image… 

 
Right-click on the image to 
display a shortcut menu and 
select Format Picture to open 
the Format Picture pane 

 
Click on the Picture icon below 
the Format Picture heading to 
display the Picture options, 
then click on PICTURE 
COLOUR to expand this 
category 

 
Click on the drop arrow for 
Recolour and select Black and 
White 50% 

Notice the recolouring is 
updated immediately on your 
slide…  

 
Click on [Reset] to undo the 
change 

 
Under Colour Tone, click and 
drag the zoom slider for 
Temperature to the right until it 
reaches 7200 to apply this tone 

Notice that the image contains 
more red, so the temperature is 
‘warmer’ 

 

2 3 

4 

For Your Reference… 

To recolour an image: 

1. Click on the image to select it 

2. Click on the Picture Tools: Format tab, then 
click on Colour in the Adjust group 

3. Click on a Colour Saturation, Colour Tone 
or Recolour option to apply 

Handy to Know… 

 You can access preset image colour options 
via the ribbon. To do so, click on the Picture 
Tools: Format tab and click on Colour in 
the Adjust group to display a gallery of 
options to choose from. 

6 
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APPLYING A PICTURE STYLE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Picture styles are great when you want the 
image to stand out, or to enhance the image in 
some way. By applying picture styles, you can 
apply borders to images, or change the shape of 

the image, as well as apply special effects such as 
reflection and glow. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file Enhancing 
Images_4.pptx... 

 
Click on slide 2 to display it in 
the Slide window, then select 
the image 

 
Click on the Picture Tools: 
Format tab, then click on the 
More arrow in the Picture 
Styles group to display the 
Picture Styles gallery 

The gallery contains a range 
of predesigned picture styles 
that you can apply… 

 
Point to several of the styles 
to view the result on the 
image in Live Preview 

 
Click on Rotated, White to 
apply this style to the image, 
then deselect the image to 
view the result 

 

2 

For Your Reference… 

To apply a picture style to an image: 

1. Click on the image to select it 

2. Click on the Picture Tools: Format tab, then 
click on the More arrow in the Picture 
Styles group 

3. Click on a picture style to apply 

Handy to Know… 

 You can modify an applied picture style. To 
do this, select the image, click on the Picture 
Tools: Format tab, then click on Picture 
Border in the Picture Styles group, to add 
or modify a picture border, or click on 
Picture Effects to add effects or to modify 
the applied effects. 

4 
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 APPLYING PICTURE EFFECTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PowerPoint is designed to help you create 
powerful and professional-looking presentations 
quickly by using available templates, themes and 
styles. But with the range of image editing tools 

and effects that you can apply to images and other 
objects, you may find that you will want to spend 
more time in PowerPoint editing images. 

2 
Try This Yourself: 

S
a

m
e

 

F
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 Continue using the previous file 

with this exercise, or open the file 
Enhancing Images_5.pptx... 

 
Navigate to and display slide 3 in 
the Slide window, then click on the 
image to select it 

Let’s add a perspective effect to the 
clip art image to give it a shadow… 

 
Resize the image so it is about 
13cm wide, then move it up 

 
Right-click on the image to display 
the shortcut menu and select 
Format Picture to open the 
Format Picture pane 

 
Ensure the Effects icon is selected 
below the Format Picture heading, 
then click on SHADOW to expand 
this category and display the 
available options 

 
Click on the drop arrow for Presets 
and select Perspective Diagonal 
Upper Left under Perspective to 
apply this effect 

 
Drag the zoom slider for 
Transparency to set it to about 
30%, making the shadow less 
transparent 

 
Select the value in Size and type 
200% to see the effect – it’s now 
very big – then reset Size to 100% 

 
Select the value in Transparency 
and type 60 (%) 

 

5 

For Your Reference… 

To apply picture effects to an image: 

1. Click on the image to select it 

2. On the Picture Tools: Format tab, click on 
Picture Effects in the Picture Styles group 

3. Select an effect, then select a pre-set option 

Handy to Know… 

 To see what an image might look like with a 
picture effect applied, click on the Picture 
Tools: Format tab, click on Picture Effects 
in the Picture Styles group and point to a 
category to display a menu of preset effects. 
Pointing to each effect applies it in Live 
Preview. 

7 
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APPLYING ARTISTIC EFFECTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PowerPoint provides you with a range of artistic 
effects which allow you to be as creative as you 
like. Using the artistic effects you can do things 
such as make your images look like drawings or 

paintings. You can apply a combination of effects to 
create something totally new or stick with one effect 
that works. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file with 

this exercise, or open the file 
Enhancing Images_6.pptx... 

 
Ensure slide 3 is displayed in the 
Slide window, then click on the 
image to select it 

 
Click on the Picture Tools: Format 
tab, then click on Artistic Effects in 
the Adjust group to display the 
Artistic Effects gallery 

You can choose from a range of pre-
set effects. If you hover over an 
option, you can view a Live Preview 
of the result. However we would like 
to have more control over the artistic 
effect we apply… 

 
Select Artistic Effects Options from 
the bottom of the menu to display the 
Format Picture pane 

 
In Effects, click on the drop arrow for 
Artistic Effects under Artistic 
Effects, to display the gallery 

 
Click on Cement (column 1, row 4) to 
apply this effect 

Two options have become available 
below Artistic Effects in the Format 
Picture pane… 

 
Select the value for Crack Spacing 
and type 80 to smooth the effect 

 
Click on [Reset] then repeat steps 4 
and 5 to reapply the Cement effect at 
the default settings 

 

2 

5 

For Your Reference… 

To apply artistic effects to an image: 

1. Click on the image to select it 

2. Click on the Picture Tools: Format tab, then 
click on Artistic Effects in the Adjust group 

3. Click on an artistic effect to apply 

Handy to Know… 

 The options that become available in the 
Format Picture pane once you have 
selected an Artistic Effect will differ 
depending on the effect you have chosen. 
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CROPPING AN IMAGE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To crop an image is to trim it and remove parts 
of the image that you don’t want to see. When 
you crop an image, you are actually masking 
that part of the image so that it becomes hidden. 

Cropping an image does not affect the actual file or 
impact on file size in any way. You can crop an 
image from any or all of its four sides. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the file 
Enhancing Images_7.pptx... 

 
Click on slide 4 to display it in the 
Slide window, then select the 
image 

 
Click on the Picture Tools: 
Format tab and click on the top 
half of Crop in the Size group 

Cropping handles will appear 
around the image. You can click 
and drag on any handle to crop. 

Let’s remove the bush from the 
bottom of the image… 

 
Point to the bottom centre crop 
handle until the pointer appears 
as a T shape, as shown, then 
click and drag upwards about 
halfway 

 
Release the mouse, then click 
elsewhere to apply the crop 

This crop is a bit excessive… 

 
Click on the image and repeat 
step 2 to display the crop handles 

Notice the grey area below… 

 
Click and drag the bottom centre 
crop handle down to reduce the 
size of the crop and reveal some 
people on the beach, then click 
elsewhere to apply the changes 

 

3 

4 

For Your Reference… 

To crop an image: 

1. Click on the image, then click on the Picture 
Tools: Format tab and click on the top half 
of Crop 

2. Click and drag a cropping handle to exclude 
parts of the image as required, then click 
elsewhere to apply the crop 

Handy to Know… 

 To crop to a shape, select the image, click on 
the Picture Tools: Format tab, click on the 
bottom half of Crop in the Size group, point 
to Crop to Shape and select the desired 
shape. You can then either accept the 
default crop or select Fill to choose which 
part of the image is cropped. 

6 
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CHAPTER 6 SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 learn how to draw shapes 

 learn how to resize shapes 

 learn how to edit shapes 

 learn how to position shapes 

 learn how to arrange shapes 

 learn how to merge shapes 

 learn how to format shapes 

 learn how to use the eyedropper tool 

 learn how to copy shapes 

 learn how to align shapes 

 learn how to align shapes using the smart guides 

 learn how to insert and format text in shapes 

 learn how to add connectors to shapes 

 learn how to group shapes 

 learn how to rotate shapes. 

PowerPoint provides many ready-made shapes that you can draw 
and insert onto your slides, including lines, rectangles, icons, 
arrows, stars, banners, buttons, equation shapes, and the like. By 
drawing shapes, you can communicate plans, diagrams, flowcharts, 
processes and much more. Or, you can draw shapes to highlight or 
to embellish a particular point or aspect of a slide. 

Shapes can also be edited and formatted like any other object in 
PowerPoint. 

INFOCUS 
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DRAWING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To draw a shape, simply select the desired 
shape from the Shapes gallery, then click and 
drag on the slide to create the shape. Once 
drawn, you can then edit and format the shape 

as required, such as resizing or rotating the shape, 
or changing the colour or style. In this exercise you 
will draw a block arrow and a circle to add visual 
interest to the title slide. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file 
Shapes_1.pptx… 

 
Select slide 1 in the Slides 
pane to display it in the Slide 
window 

 
Click on the Insert tab, then 
click on Shapes in the 
Illustrations group to display 
the Shapes gallery 

The Shapes gallery lists all the 
shapes that you can draw… 

 
Click on Right Arrow under 
Block Arrows, then point to 
just below the subtitle 

 
Hold down the left mouse 
button and drag across to the 
right and down slightly to 
create a block arrow 

Don’t worry about the size or 
position of the arrow at this 
stage. Let’s draw a circle… 

 
Repeat step 2 to display the 
Shapes gallery 

 
Click on Oval under Basic 
Shapes, press and hold , 

then click and drag to create a 
circle, as shown, before 
releasing the mouse button 

and then  

Pressing  ensures that you 
create a perfect circle 

 

2 

3 

For Your Reference… 

To draw shapes: 

1. Click on the Insert tab, then click on Shapes 
in the Illustrations group 

2. Click on a shape to select it, then click and 
drag on the slide to draw the shape 

Handy to Know… 

 Once you have selected a shape from the 
Shapes gallery, instead of clicking and 
dragging to draw the shape on the slide, you 
can click once to insert it at its default size. 

 Press and hold  while drawing a line or 

arrow to ensure it is straight. 

6 
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RESIZING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once you have drawn a shape, you may need to 
resize it to suit your requirements. Shapes can 
be resized like any other object, by clicking and 
dragging on any of the control handles. You can 

press  while dragging, to resize the shape 

proportionately (both width and height). For more 
precise resizing, you can specify the exact height 
and width dimensions. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file 
Shapes_2.pptx... 

 
Ensure slide 1 is displayed in 
the Slide window 

Let’s make the arrow wider… 

 
Click on the arrow to select it 
and display the placeholder 
handles, then point to the 
bottom middle handle, as 
shown 

 
Click and drag down to 
adjust the height, as shown 

Let’s now resize the arrow by 
specifying the dimensions… 

 
With the arrow selected, click 
on the Drawing Tools: 
Format tab, then click on the 
up spinner arrow for Height 
in the Size group until the 
height is 6.8 cm 

 
Repeat step 4 to change the 
Width to 14.5 cm 

 
Select the circle, then hold 
down  and click and drag 

the bottom left corner handle 
to resize the circle as shown 

 

2 

3 

For Your Reference… 

To resize shapes: 

1. Select the shape 

2. Click and drag on a border handle, or 

 Click on the Drawing Tools: Format tab and 
adjust the Height and Width in the Size 
group 

6 

Handy to Know… 

 When resizing shapes, on the Drawing 
Tools: Format tab, click on the dialog box 
launcher for the Size group to open the 
Format Shape pane to display more 
advanced resizing options. 
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EDITING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Many of the shapes available in PowerPoint can 
be edited in some way. This means that you can 
customise or reshape them. When selected, 
shape placeholders display white handles. 

Shapes that can be edited, however, will also 
display yellow handles in specific areas indicating 
where the shape can be altered. Click and drag on 
a yellow handle to modify the shape. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the 
previous file with this 
exercise, or open the file 
Shapes_3.pptx... 

 
Ensure slide 1 is displayed 
in the Slide window, then 
select the arrow 

Notice that two yellow 
handles appear on this 
shape. 

Let’s edit the shape so that 
the arrowhead is longer 
and narrower… 

 
Point to the yellow handle 
at the top of the arrowhead 
until the pointer changes to 
a small arrow, as shown 

 
Click and drag the handle 
to the left 

 
Deselect the shape to view 
the result 

 

2 

3 

For Your Reference… 

To edit shapes: 

1. Select the shape to be edited 

2. Click and drag on a yellow handle 

Handy to Know… 

 For even greater control over the shape of an 
object, select it, click on the Drawing Tools: 
Format tab, then click on Edit Shape in the 
Insert Shapes group and select Edit Points. 
You can then click and drag on any point (or 
corner) of the object to reshape it. 

4 
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POSITIONING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you draw shapes you might need to 
reposition them. The easiest methods for 
positioning shapes is to either drag the selected 
shape to a new location or to use the arrow keys 

( , ,  and ). Alignment guides (dotted 
lines) may appear when moving shapes. This 
indicates when a shape is aligned with a nearby 
object making it easy for you to position neatly. 

Try This Yourself: 

S
a

m
e

 

F
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e
 

Continue using the previous 
file with this exercise, or 
open the file 
Shapes_4.pptx... 

 
Ensure slide 1 is displayed 
in the Slide window, then 
click on the arrow to select it 

Let’s move the arrow into 
position… 

 
Click and drag the arrow 
upwards so it sits over the 
text Transport as shown 

The text is now hidden 
behind the shape. Guides 
appear to help you align the 
shape on the page. 

Let’s now move the circle 
into position… 

 
Click on the circle to select 

it, then press  and  to 
move the circle into position, 
as shown 

 

1 

2 

For Your Reference… 

To position shapes: 

1. Select the shape 

2. Click and drag the shape, or 

 Use , ,  and/or  

Handy to Know… 

 When positioning shapes, you can use 
gridlines to help you to position or draw your 
shapes precisely. To view gridlines, click on 
the View tab, then click on the checkbox for 
Gridlines in the Show box until it appears 
with a tick. Repeat this until Gridlines 
appears without a tick to hide gridlines. 

3 
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ARRANGING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When working with multiple shapes and objects 
on a slide, you will often find that some objects 
overlap or hide others. This is because as 
shapes are added to the slide, they are placed in 

a stacking order – the most recent shape residing 
in the top-most layer. In PowerPoint you can 
arrange shapes, restacking them to bring shapes 
in front of or behind other shapes. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Shapes_5.pptx... 

 
Ensure slide 1 is displayed in 
the Slide window 

 
Select the arrow, then press 

 and click on the circle to 

select both shapes 

 
Click on the Drawing Tools: 
Format tab, then click on the 
bottom half of Send 
Backward in the Arrange 
group and select Send to 
Back 

Both shapes will be sent 
behind all other objects… 

 
Use the arrow keys to 
position the shapes behind 
the text as shown 

Let’s reposition the arrow so 
it is in front of the circle… 

 
Click away from the shapes 
to deselect them, then select 
the arrow again 

 
Click on the Drawing Tools: 
Format tab, then click on the 
top half of Bring Forward in 
the Arrange group to bring 
the arrow in front of the circle 

 

3 

4 

For Your Reference… 

To arrange shapes: 

1. Select the shape(s) to be arranged 

2. Click on the Drawing Tools: Format tab, 
then click on the top half of Send Backward 
or Bring Forward in the Arrange group and 
select an option 

Handy to Know… 

 When arranging objects, you are actually 
layering objects on top of one another. When 
you send an object to the back or front, it 
sits behind or in front of all other objects, so 
that it becomes the bottom or top layer. To 
send backward or bring forward will send 
an object behind or forward one layer only. 

6 
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MERGING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can select two or more shapes on a slide 
and combine them to create a custom shape. 
The Merge Shapes tool can be used to perform 
a variety of different types of merge, such as 

Combine which cuts out the part of the shape that 
overlaps with another, or Union which merges the 
selected shapes into one. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Shapes_6.pptx... 

 
Ensure slide 1 is displayed in 
the Slide window 

Let’s try an easy way of 
selecting multiple shapes… 

 
Point above and slightly to the 
left of the circle, then click 
and drag down diagonally to 
the right to draw a selection 
marquee around the circle 
and arrow shapes 

When you release the mouse 
button, both shapes will be 
selected… 

 
Click on the Drawing Tools: 
Format tab, then click on 
Merge Shapes in the Insert 
Shapes group to display a 
menu of options 

 
Point to each of the options to 
view the effect on the shapes 
in Live Preview 

 
Select Union to merge the 
two shapes into one shape 

You can see that this is now a 
single shape as there is only 
a single placeholder border 

 

2 

For Your Reference… 

To merge shapes: 

1. Select the shapes you wish to merge 

2. Click on the Drawing Tools: Format tab, 
then click on Merge Shapes in the Insert 
Shapes group 

3. Select an option 

5 

Handy to Know… 

 The Merge Shapes tool also includes Shape 
Intersect and Shape Subtract. Shape 
Intersect will remove all parts of the shape 
except the area where two or more objects 
overlap. Shape Subtract will crop or cut 
holes in the shape in the form of the 
overlapping object(s). 

3 
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FORMATTING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you draw shapes, they are formatted in 
line with the applied theme. Formatting includes 
applied colours, fonts and effects. If you’re not 
entirely satisfied with the default formatting, you 

can apply a shape style to the shape. Each shape 
style is preformatted and consists of a particular 
colour set, font and font size, borders and shading, 
as well as effects such as gradient fills. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the 
previous file with this 
exercise, or open the file 
Shapes_7.pptx... 

 
Ensure slide 1 is displayed 
in the Slide window, then 
select the arrow shape 
behind the text 

 
Click on the Drawing 
Tools: Format tab, then 
click on the More arrow for 
the Shape Styles gallery 
in the Shape Styles group 
to display a gallery of 
options 

Here you can select from a 
range of preformatted 
shape styles… 

 
Point to the various shape 
styles to see them applied 
temporarily to the shape in 
Live Preview 

 
Click on Light 1 Outline, 
Coloured Fill, Blue, 
Accent 6 (column 7, row 
3) to apply this shape style 

 

2 

3 

For Your Reference… 

To format shapes: 

1. Select the shape(s), then click on the 
Drawing Tools: Format tab 

2. Click on the More arrow for the Shape 

Styles gallery and select a shape style 

Handy to Know… 

 Once you have applied a shape style, you 
can then alter individual elements of the style 
if required, including the colours, fonts and 
effects. To do this, select the shape, then 
use the Shape Fill, Shape Outline and 
Shape Effects tools in the Shape Styles 
group to customise the shape style. 

4 
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USING THE EYEDROPPER 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Making various elements on your slide the same 
colour ties them together and creates visual unity 
for your content. The eyedropper tool makes 
colour matching a breeze. Not only can you pick 

colours from within PowerPoint but you can also 
match colours from other formats such as a 
website. 

Try This Yourself: 

 

Continue using the previous file 
with this exercise, or open the file 
Shapes_8.pptx... 

 
Ensure slide 1 is displayed in the 
Slide window and the shape is 
selected 

 
Click on the Drawing Tools: 
Format tab, then click on Shape 
Fill in the Shape Styles group to 
display a gallery of options 

 
Select Eyedropper 

The pointer changes to an 
eyedropper and can now pick up 
the colour to which it is pointing… 

 
Point to the dark red colour in the 
bottom left corner of the slide, then 
click to fill the shape with this 
colour 

 
Repeat steps 3 and 4 to activate 
the Eyedropper again 

 
Click and drag (without releasing 
the mouse button) to any of the 
slides that are visible in the slides 
pane and point to a colour 

In this example we have chosen a 
yellow colour from the background 
of slide 4. We could have taken this 
colour from slide 1 but want to 
demonstrate that you can select 
colours from other slides… 

 
Release the mouse button 

The shape on slide 1 will now be 
filled with the colour you selected 

 

3 

4 

For Your Reference… 

To select colours using the eyedropper: 

1. Select the shape 

2. Click on the Drawing Tools: Format tab, 
click on Shape Fill in the Shape Styles 
group and select Eyedropper 

3. Point to a colour and release the mouse 
button to apply the colour 

Handy to Know… 

 You can use the eyedropper to pick a colour 
from an external source, such as a website. 
To do so, have both your presentation and 
the other source open on your screen, select 
the eyedropper, click in your presentation, 
drag to the colour in the other source and 
release the mouse button to apply the colour. 

6 
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COPYING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Where you are using the same shape repeatedly, 
it is easier, quicker and more precise to copy the 
existing shape instead of redrawing it each time. 
Copying shapes works the same way as copying 

other objects. When you copy a shape it is placed 
onto the clipboard, ready for you to paste onto the 
slide. Here you will draw a rectangle and copy it 
several times in preparation for a drawing. 

Try This Yourself: 

 

Continue using the previous file 
with this exercise, or open the file 
Shapes_9.pptx... 

 
Select slide 6 in the Slides pane 
to display it in the Slide window 

 
Click on the Insert tab, then click 
on Shapes in the Illustrations 
group to display the Shapes 
gallery 

 
Select Rounded Rectangle 
under Rectangles, then click and 
drag below the slide text to create 
a small rectangle, as shown 

 
With the rectangle selected, click 
on the Home tab, then click on 
Copy in the Clipboard group to 
copy the rectangle onto the 
clipboard 

Let’s paste the rectangle onto the 
slide… 

 
Click on the top half of Paste in 
the Clipboard group to paste a 
copy of the rectangle 

Let’s try a quicker method using 
keyboard shortcuts… 

 
With the rectangle selected, press 

 +  to copy it 

 
Press  +  to paste the 
shape 

 
Press  +  two more times to 
paste two more copies of the 
shape to create 5 in total 

 

3 

4 

5 

For Your Reference… 

To copy shapes: 

1. Select the shape to be copied 

2. Click on the Home tab, then click on Copy in 
the Clipboard group 

3. Click on the top half of Paste in the 
Clipboard group 

Handy to Know… 

 As well as copying and pasting shapes to 
copy existing shapes, you can also 
duplicate shapes. To do this, select the 
shape, click on the Home tab, then click on 
the drop arrow for Copy and select 
Duplicate. The shape will be copied and 
pasted in a single step rather than two. 

8 
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ALIGNING SHAPES USING THE RIBBON 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you are working with multiple shapes and 
objects, you can arrange the objects so they are 
aligned with other objects. Aligning objects 
means that they line up with each other on the 

slide, which improves the overall layout. An 
audience will respond better to a slide where 
objects are aligned than they will to the random 
placement of shapes. 

Try This Yourself: 

 

Continue using the previous file 
with this exercise, or open the file 
Shapes_10.pptx... 

 
Ensure slide 6 is displayed in the 
Slide window 

 
Select the top rectangle if 
necessary, then click and drag it 
into position, as shown 

 
Repeat step 2 to position the 
remaining rectangles, as shown 

 
Select one rectangle, then press 

and hold  and click on each 
rectangle to select all five 

 
Click on the Drawing Tools: 
Format tab, then click on Align in 
the Arrange group and select 
Distribute Horizontally 

All shapes will be distributed 
evenly with equal space on the 
right and/or left sides of the 
shapes… 

 
Deselect all shapes, then select 
the three top shapes 

 
Click on Align in the Arrange 
group and select Align Top 

The selected shapes will be 
aligned with the top of the highest 
shape. You could also use Align 
Bottom or Align Middle for this 
selection… 

 
Select the two lower shapes, then 
click on Align in the Arrange 
group and select Align Bottom 

 

2 

3 

5 
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For Your Reference… 

To align shapes: 

1. Select the shapes to align 

2. Click on the Drawing Tools: Format tab, 
then click on Align in the Arrange group and 
select an alignment option 

Handy to Know… 

 You can align objects with other objects or 
with the slide. To align to the slide, select the 
object(s), then click on Align in the Arrange 
group on the Drawing Tools: Format tab 

and selecting Align to Slide. 



Microsoft PowerPoint 2016 - Advanced 

© 2017 The University of Nottingham Page 70 Chapter 6 - Shapes 

 ALIGNING OBJECTS USING THE SMART GUIDES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Smart guides are very handy if you want to 
quickly and easily align objects on your slides. 
Not only can you use the guides to align objects 
and text, but you can also use them to evenly 

space objects so that their top, bottom, left or right 
margins are aligned. As you move objects, dotted 
orange lines and arrows appear (shown in white 
here for clarity) when they are aligned. 

Try This Yourself: 

S
a

m
e

 

F
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e
 

Continue using the previous 
file with this exercise, or 
open the file 
Shapes_11.pptx... 

 
Select slide 10 in the Slides 
pane to display it in the Slide 
window 

 
Click on the plane to select it, 
then drag it slightly to the 
right and up until the two 
smart guides appear as 
shown 

The plane is right-aligned 
with the heading frame and is 
bottom-aligned with the car… 

 
Select the bike and drag it 
slightly to the right and up 
until the smart guides appear 
as shown 

The distance between the 
bike and the bottom of the 
car and the distance between 
the top of the plane and the 
top of the car are the same 
as shown by the arrows… 

 
Drag the car to the right until 
the smart guides appear as 
shown 

The car and the bike are now 
centre aligned and the 
distance between each 
object is the same… 

 
Move the plane down slightly 
so that it is centre aligned 
with the other two images 

2 

3 

For Your Reference… 

To align objects using the smart guides: 

1. Drag the first object into position 

2. Drag the next object until the smart guides 
appear showing the two objects aligned 

To evenly space three or more objects: 

 Drag the objects until double-headed arrows 
appear 

Handy to Know… 

 You can use smart guides to resize an object 
so that two objects align. To do this, move 
the object to be resized as required, then 
drag the appropriate centre resizing handle 
(right to right-align shapes, bottom to bottom-
align shapes, etc.) until the smart guide 
appears showing they are aligned. 

5 
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INSERTING AND FORMATTING TEXT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7 

Shapes also act like a text box. This means you 
can type directly into a shape if required. When 
you insert text, it will be preformatted in line with 
the applied theme or shape style and will be 

centred in the shape. Once inserted, text can be 
formatted like any other object. In this exercise you 
will label each rectangle and then format the text to 
make it larger. 

Try This Yourself: 

S
a

m
e
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Continue using the previous 
file with this exercise, or 
open the file 
Shapes_12.pptx... 

 
Select slide 6 in the Slides 
pane to display it in the 
Slide window 

 
Click on the top left 
rectangle to select it, then 
type Create 

 
Click on the rectangle to the 
right and type Storage 

 
Repeat the above steps to 
type the following text into 
the remaining three 
rectangles: 

Ship 
Market 
Review 

 
Select all five rectangles 

Let’s format the text… 

 
Click on the Home tab, 
select the value in Font 
Size in the Font group and 
type 22, then press  to 

increase the text size 

 
Deselect all shapes to view 
the result 

 

2 

4 

For Your Reference… 

To insert and format text: 

1. Select the shape and type the required text 

2. Click on the Home tab and apply formatting 
using the commands in the Font and 
Paragraph groups 

Handy to Know… 

 You can use any of the formatting tools in the 
Font and Paragraph groups on the Home 
tab to format the text in a selected shape. 
You can also use the text formatting tools in 
the WordArt Styles group on the Drawing 
Tools: Format tab. 
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PowerPoint lets you connect shapes (or any 
objects for that matter) with arrows and lines 
called connectors. Connecting shapes is 
particularly useful when depicting processes or 

steps. When you rearrange connected shapes, the 
connectors remain attached and move with the 
shapes. This means that you don’t need to select 
and move the lines as well as the shape. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the file 
Shapes_13.pptx... 

 
Ensure slide 6 is displayed in the 
Slide window 

 
Click on the Insert tab, then click 
on Shapes in the Illustrations 
group to display the Shapes gallery 

 
Select Arrow under Lines and 
point to the Create rectangle 

Notice that four connector points 
appear around the shape… 

 
Point to the connector point on the 
right border, then click and drag to 
the Storage rectangle 

 
When the pointer is over the left 
connector of the Storage rectangle, 
release the mouse button 

When shapes are connected, a 
green connector point will appear 
on each connected shape… 

 
Repeat steps 2 to 5 to connect the 
Storage and Ship rectangles 

 
Repeat step 2 to select Elbow 
Arrow Connector under Lines 

 
Click on the bottom connector point 
of the Ship rectangle and drag to 
the connector point on the right 
border of the Review rectangle 

 
Repeat steps 2 to 5 to draw a 
connector from the Review 
rectangle to the Market rectangle 

 

3 

5 

For Your Reference… 

To connect shapes: 

1. Click on the Insert tab, then click on Shapes 
in the Illustrations group and select Line, 
Arrow, Double Arrow or one of the 
Connectors 

2. Click on a connector point and drag to the 
connector point of the connecting shape 

Handy to Know… 

 To reroute a connector between shapes, 
click on the line or arrow, then click and drag 
the red dot that appears at either end of the 
connector to the new location. 

 To delete a connector, click on the line or 
arrow to select it, then press . 

9 
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When working with multiple shapes, such as 
where you have drawn a number of individual 
objects to make up a single diagram, you may 
find it easier to work with the shapes if they are 

grouped. Grouped shapes act as a single object 
and as such, can be moved, aligned and formatted 
as a single object. Here you will group various 
shapes and then format the grouped object. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the 
file Shapes_14.pptx... 

 
Ensure slide 6 is displayed in the 
Slide window 

 
Draw a selection marquee to 
select all shapes 

Let’s group and then format the 
lines… 

 
Click on the Drawing Tools: 
Format tab, then click on Group 
in the Arrange group to display 
a menu of options and select 
Group to group the selected 
objects 

Notice there is now a single 
bounding box around all the 
shapes, including the lines. 

You can now apply formatting to 
all shapes at once… 

 
With the group selected, click on 
the More arrow in the Shape 
Styles group and click on 
Coloured Fill – Orange, Accent 
2 (column 3, row 2) to apply this 
shape style to the group 

 
With the group selected, click on 
Shape Outline in the Shape 
Styles group, then point to 
Weight and select 3 pt 

 

2 

3 

For Your Reference… 

To group shapes: 

1. Select the shapes and objects to group 

2. Click on the Drawing Tools: Format tab, 
then click on Group in the Arrange group 

and select Group 

Handy to Know… 

 To separate grouped objects, select the 
grouped object, click on the Drawing Tools: 
Format tab, then click on Group in the 
Arrange group and select Ungroup. 

 To edit individual objects within a grouped 
object, select the grouped object, then click 
on the individual object and edit as required. 

5 
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As with other objects, you can rotate a shape to 
a certain degree from its current axis. For 
example, you can rotate a shape to 45° from its 
current position. Shapes can be rotated in any 

direction. You can freely rotate a shape by 
dragging the rotate handle that appears for a 
selected shape, or you can specify the position to 
rotate to by using the Rotate tool. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Shapes_15.pptx... 

 
Select slide 8 in the Slides 
pane to display it in the Slide 
window 

 
Click on the Insert tab, then 
click on Shapes in the 
Illustrations group to display 
the Shapes gallery and select 
Circular Arrow under Block 
Arrows 

 
Press and hold , then click 

and drag on the slide to draw 
a circular arrow, as shown 

Don’t worry too much about 
the size… 

 
Click on the Home tab, then 
click on the drop arrow for 
Copy in the Clipboard group 
and select Duplicate 

Let’s now rotate the copied 
shape… 

 
Click on the Drawing Tools: 
Format tab, then click on 
Rotate in the Arrange group 
and select Rotate Right 90° 

 
Repeat step 5 to rotate the 
shape again, then reposition 
the arrows as shown 

 

3 

5 

For Your Reference… 

To rotate shapes: 

1. Select the shape 

2. Click on the Drawing Tools: Format tab, 
then click on Rotate in the Arrange group 
and select a rotation option 

Handy to Know… 

 You can freely rotate selected objects. To do 
this, click on the rotate handle that appears 
above the selected shape, then drag the 
handle to the right or left to rotate. 

 If you make a mistake when drawing shapes, 

press  +  to undo the change, or select 

the shape and press . 

6 
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CHAPTER 7 MEDIA AND ACTION BUTTONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of media  

 learn how to insert an online video 

 learn how to insert an audio clip 

 learn how to format media clips 

 learn how to edit audio clips 

 learn how to optimise and compress media 

 gain an understanding of action buttons 

 learn how to insert action buttons. 

PowerPoint presentations can be enhanced with the careful use of 
multimedia, such as movies, animated GIF files, sound clips and 
voice narration. As such, you can insert sound and video clips onto 
your slides. 

And if you are developing your presentation for other people to use, 
you can ensure that they will find it easy to navigate by inserting 
action buttons onto each slide, so that users can click on the 
button to easily navigate through the presentation. 

INFOCUS 
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UNDERSTANDING MEDIA IN POWERPOINT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Often, the difference between an adequate and a 
great presentation lies in the careful use of 
multimedia. You can grab your audience and 
maintain their attention by incorporating audio 

and video clips. This media can be used to 
emphasise key points, control the focus of the 
discussion, or simply entertain during an otherwise 
dull presentation. The key is to not overdo it. 

Video and Audio File Formats 

Sometimes the most effective way to get your message across is to insert a video or animation into your 
presentation. For example, you may include a video clip of an expert speaker who cannot attend the 
actual presentation. In PowerPoint, video refers to digital video. 

PowerPoint supports a range of digital video formats, including Windows media files (ASF, WMV), 
Windows video files (AVI), QuickTime movie files (MOV), MP4, movie files (MPG, MPEG, MPEG-2) and 
Adobe Flash files (.SWF). The digital video format which is selected in PowerPoint by default is MPEG-4 
video and this is the format which will provide you with the best playback experience. 

You may also want to add audio to your presentation, particularly if it is a presentation which will be 
played automatically such as at a trade show or in a shop. PowerPoint supports a range of audio file 
formats, including AIFF, UNIX audio (AU), MIDI files, MP3 files, Windows audio files (.WAV) and 
Windows Media Audio files (WMA). 

For a detailed list of supported and compatible media files, visit www.microsoft.com and conduct a 
search (for example, PowerPoint 2016 video audio file formats). 

Inserting Media Clips 

When you insert a media clip, the clip is embedded onto the slide by default. When you embed a clip, it 
is contained within the presentation, and as such, can significantly increase the overall file size of the 
presentation. PowerPoint includes a range of options for compressing and optimising clips to reduce 
file size for a range of presentation modes (such as the Internet). 

Alternatively, where file size is still an issue, you can create a link from the file to the presentation. Then, 
when you insert a clip, PowerPoint creates a link to the clip’s file location. Because of this, it is good 
practice to store the media files in the same folder as your presentation before you insert them. You will 
then need to ensure that you ‘package’ the media file with the presentation when distributing to others. 

Editing Media Clips 

When you insert a media clip, the contextual Video Tools: Playback tab (for video) and the Audio 
Tools: Playback tab (for audio) becomes available, which contains a range of tools to edit and set 
timings for media clips. For example, you can trim the clip if you don’t want the clip played from 
beginning to end, or you can set the clip to loop continuously until you manually stop or pause it. You 
can also adjust the volume, play full screen or select whether the clip is to start automatically or on click. 

Note: After initial release, there was a documented problem with inserting online videos into PowerPoint. 
This problem also affects the Video Tools: Playback tab. If Microsoft Updates are regularly installed, you 
should not experience these difficulties. 

Formatting Media Clips 

If you want to edit the actual look of the video or audio clip as it appears within your presentation you can 
use the tools on the Video Tools: Format tab or Audio Tools: Format tab (see below), depending on 
what type of clip you are working with. 

This is the left half of the ribbon displaying the Preview, Adjust 
and Video Styles groups on the Video Tools: Format tab. 

This is the right half of the ribbon displaying the Arrange and 
Size groups on the Video Tools: Format tab. 

 

http://www.microsoft.com/
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 INSERTING AN ONLINE VIDEO 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you insert a video clip onto a slide, the file 
will be embedded into the presentation by 
default, which means that it is contained within 
the presentation and is not just a link to the 

presentation. There are two ways to insert a video. 
You can click on Insert Video in a content 
placeholder, or where a placeholder isn’t available, 

use the relevant commands on the Insert tab. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise you 

MUST open the file Media And 
Action Buttons_1.pptx… 

 
Navigate to and display slide 5 in 
the Slide window if required 

Let’s insert a short video clip… 

 
Click on the Insert tab, then click 
on the bottom half of Video in 
the Media group to display a list 
of insert options 

 
Select Online Video to open the 
Insert Video pane 

 
Click on the search box next to 
YouTube, then type renewable 
energy and press  to display 

the results 

 
Click on a thumbnail to select the 
video, then click on [Insert] 

In this example we have selected 
BEHIND THE SCIENCE – 
Renewable Energy… 

 
Ensure the Video Tools: 
Format tab is selected, then 
click on Play in the Preview 
group and click on the Play 
button in the video if necessary 

The video should now start – an 
initial documented problem 
inserting and playing online 
videos should no longer occur if 
Microsoft updates are regularly 
installed 

 

2 

5 

6 

TIP: You can also insert a video that is already saved on to 
your computer. Simply click on the INSERT tab, click on Video 
in the Media group and select Video on My PC. The Insert 
Video dialog box will display and you can locate and select the 
required video.  

For Your Reference… 

To insert an online video: 

1. Click on the Insert tab, then click on Video 
in the Media group 

2. Select Online Video, type in your search 
term and press   

3. Select a video and click on [Insert] 

Handy to Know… 

 You can insert a linked media file rather 
than embedding media into your 
presentation. To do this click on the Insert 
tab, click on Video in the Media group, 
select Video on My PC, navigate to the 
required media file then click on the drop 

arrow for [Insert] and select Link to File. 
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When you insert an audio file onto a slide, the 
clip will be embedded into the presentation by 
default and will appear as a speaker icon on the 
slide. Once inserted, you can then edit the audio 

clip in much the same way as you would edit video 
clips. Audio clips can be inserted using the Audio 
command on the Insert tab, and then edited using 
the commands on the Playback tab. 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Media And Action 
Buttons_2.pptx... 

 
Display slide 6 in the Slide 
window 

 
Click on the Insert tab, 
then click on Audio in the 
Media group and select 
Audio on My PC to 
display the Insert Audio 
dialog box 

 
Navigate to the Course 
Files for Microsoft 
PowerPoint 2016 folder 
and locate the Audio.mp4 
file 

The results for the search 
term birds will appear… 

 
Ensure the file is selected, 
then click on [Insert] 

 
With the audio icon 
selected (to display the 
audio toolbar below), click 
on Play/Pause to play the 
audio clip 

 

2 

3 

For Your Reference… 

To insert an audio clip: 

1. Click on the Insert tab, then click on Audio 
in the Media group 

2. Locate the clip and click on [Insert] 

3. Click on the Audio Tools: Playback tab to 
work with the audio options 

Handy to Know… 

 If you attach a microphone, you can record 
your own audio and save it to your computer. 

 You can insert audio saved to your computer 
by clicking on the Insert tab, then click on 
Audio in the Media group and select Audio 
on My PC. Select the required file(s) using 
the Insert Audio dialog box. 

5 
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Improving the appearance of the media clip 
thumbnails within your presentation can greatly 
improve the look of your slides. For instance you 
may wish to format a media clip so that it 

matches the design of the rest of the slides, 
thereby maintaining a sense of cohesion 
throughout the presentation. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous file 
with this exercise, or open the file 
Media And Action 
Buttons_3.pptx... 

 
Display slide 5 in the Slide 
window then click on the video 
thumbnail to select it 

 
Click on the Video Tools: Format 
tab and click on Corrections in 
the Adjust group 

Let’s adjust the contrast… 

 
Click on Brightness: 0% 
(Normal) Contrast:+20% to apply 
this correction 

Let’s make the thumbnail stand 
out from the slide… 

 
Click on the More arrow for the 
Video Styles group to display a 
gallery of options then click on 
Canvas, Grey under Intense 

Now let’s improve the appearance 
of the audio clip icon… 

 
Display slide 6, then click on the 
audio icon to select it and click on 
the Audio Tools: Format tab 

 
Click on Picture Effects in the 
Picture Styles group to display a 
gallery of options, then point to 
Glow 

 
Click on Green, 8 pt glow, 
Accent colour 1 to apply this 
colour, then deselect the 
thumbnail to view the result 

 

4 

For Your Reference… 

To format media clips: 

1. Select the video or audio clip 

2. Click on the Video Tools: Format or Audio 
Tools: Format tab 

3. Make the desired changes 

Handy to Know… 

 You can use the Format Video pane to 
format a video clip thumbnail. Simply right-
click on the thumbnail and select Format 
Video, or click on a dialog box launcher on 
the Video Tools: Format tab, or select 
certain options from the menus available. 

 

7 
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PowerPoint provides you with a range of handy 
options for editing audio clips via the Audio 
Tools: Format tab. You can do all sorts of things 
such as set the audio to play in the background 

while your presentation is running, or trim the audio 
clip to make it shorter. You can even create a fade 
in or fade out for the clip so that it doesn’t start and 
finish too abruptly. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file Media And Action 
Buttons_4.pptx... 

 
Display slide 6 in the Slide 
window then select the audio 
clip icon so that the audio 
toolbar appears 

 
Click on the Audio Tools: 
Playback tab 

Let’s make this clip fade in… 

 
Click on the up spinner arrow 
for Fade In in the Editing 
group until it reaches 6.00 

For a preview, click on Play in 
the Preview group... 

 
Click on the drop arrow for 
Start in the Audio Options 
group and select 
Automatically 

 
Click on the checkbox for 
Hide During Show so that it 
appears with a tick 

 
Click on slide 1, then click on 
the Slide Show icon in the 
status bar to begin the slide 
show 

 
Navigate to slide 6 

The audio clip automatically 
plays when you reach this 
slide and the audio clip icon is 
not visible 

 

3 

5 

6 

For Your Reference… 

To edit audio clips: 

1. Select the audio clip 

2. Click on the Audio Tools: Playback tab 

3. Make changes as desired 

Handy to Know… 

 You can add a Bookmark to an audio or 
video clip to mark a position within the clip so 
you can quickly access it again. Simply 
navigate to where you want to add the 
bookmark, click on the Audio Tools: 
Playback tab and click on Add Bookmark in 

the Bookmarks group. 
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Embedding media into your presentation can 
increase overall file size. If you are preparing a 
presentation to distribute on the internet or to 
send via email, you can optimise and compress 

the media. Optimising a presentation will ensure 
compatibility across computers, while compressing 
a presentation will reduce its file size (along with a 
possible reduction in media quality). 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous file 
with this exercise, or open the file 
Media And Action 
Buttons_5.pptx... 

 
Click on slide 6 to display it in the 
Slide window 

 
Click on the audio icon to select it 

 
Click on the File tab to display the 
Backstage and ensure Info is 
selected in the left pane 

Here you can optimise and 
compress media… 

 
Click on [Optimise Compatibility] 
to begin the optimisation process if 
it has not been greyed out 

The Optimise Media Compatibility 
dialog box is displayed. Optimising 
enables the video to be viewed on 
any computer, even if the video 
format is not supported. Now we’ll 
compress the remaining media 
objects… 

 
Click on [Close], then click on 
[Compress Media] and select 
Internet Quality 

This option will compress to a size 
suitable for viewing on the internet. 
In this example the file is already 
compressed… 

 
Click on [Close] to close the 
Compress Media dialog box, then 
click on the Back arrow to return 
to the presentation 

 

3 

4 

For Your Reference… 

To optimise and compress media: 

1. Click on the File tab, then click on Info 

2. Click on [Optimise Compatibility], then 
click on [Close] when finished 

3. Click on [Compress Media], then click on 

[Close] when finished 

Handy to Know… 

 The Compress Media option contains two 
other compression options: Presentation 
Quality and Low Quality. Select 
Presentation Quality when you want to 
preserve current video and media quality and 
select Low Quality when you want to send 
the presentation via email, for example. 
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UNDERSTANDING ACTION BUTTONS 
 

 

 

 

 

 

Action buttons are objects that you assign 
actions to, so when the presenter or user clicks 
on that button, a specific action will be performed. 
Actions might include Next to move to the next 

slide, or Home to return to the first slide. Action 
buttons are commonly used to help users navigate 
a presentation, particularly for self-running 
presentations and kiosk displays. 

Action Buttons 

There are 12 action buttons available in the Shapes gallery. Below is a brief description of each type of 
action button and the default action they will perform when clicked on.  
 

 

The Back or Previous button will navigate to the previous slide. 

 

The Next or Forward button will navigate to the next slide. 

 

The Beginning button will navigate to the first slide. 

 

The End button will navigate to the last slide. 

 

The Home button will navigate to the first slide. This button has the same action as the 
Beginning button. 

 

The Information button has no preset action. You can use this international information 
symbol to link to a slide, an external file or a web page that includes further information 
about the slide or topic. 

 

The Return button will navigate to the last viewed slide. 

 

The Movie button has no preset action, but you can use it to open a link to a video clip that 
you have specified in the Action Settings dialog box (see picture below).  

 

The Document button has no present action, but you can use it to open a link to a 
document or program that you have specified in the Action Settings dialog box. 

 

The Sound button will play an audio clip that you have specified in the Action Settings 
dialog box. 

 

The Help button has no preset action, but you can use it to link to a slide, external file or a 
web page that includes further information about the slide or topic. 

 

The Custom button can be used to create any type of action.  

 

Action Settings Dialog Box 

When you insert an action button onto a slide, the Action 
Settings dialog box will open with a range of preselected 
options for that particular action. In the picture to the right, 
the Action Settings dialog box selects the default option 
when creating the Home action button. When clicked on, 
the presentation will navigate to the first slide. 
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While delivering your presentation, or to enable 
users to navigate your presentation, you can 
insert action buttons onto slides. These buttons, 
available in the Shapes gallery, are simply 

objects with default actions applied. Action buttons 
are particularly useful when users have to self-
navigate a presentation. Here you will insert 
several action buttons onto the slides. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous file 
with this exercise, or open the 
file Media And Action 
Buttons_6.pptx... 

 
Navigate to and display slide 1 in 
the Slide window 

Let’s insert a Forward button on 
this slide… 

 
Click on the Insert tab, then click 
on Shapes in the Illustrations 
group to display the Shapes 
gallery 

The action buttons appear at the 
bottom of the gallery… 

 
Click on Action Button: 
Forward or Next to select it, 
then click in the bottom right 
corner of the slide to insert a 
button at default size and display 
the Action Settings dialog box 

 
Click on [OK] to assign the 
default action, then drag the 
button into position if necessary 

 
Click on slide 2 to display it in 
the Slide window, then repeat 
steps 2 to 4 to insert Forward or 
Next, Back or Previous and 
Home buttons as shown, using 
the default actions 

 
Click on the Slide Show icon in 
the status bar to run the slide 
show and test the action buttons 

 

2 

3 

For Your Reference… 

To insert an action button: 

1. Click on the Insert tab, then click on Shapes 
in the Illustrations group 

2. Select the required button under Action 
Buttons then draw a button 

3. Set the Action, then click on [OK] 

Handy to Know… 

 If you want more precise control while 

drawing action buttons, hold down  while 
you draw. 

 If you copy and paste selected action buttons 
to other slides in the presentation, they will 
appear on the other slides in the same 
location as the source button. 

5 
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CHAPTER 8 ANIMATIONS AND TRANSITIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of animation 

 learn how to apply animation to text 

 learn how to apply animation to objects 

 learn how to apply multiple animation effects to an object 

 learn how to apply motion paths to objects 

 gain an understanding of the animation pane 

 learn how to set timing details for an effect 

 learn how to animate SmartArt graphics 

 learn how to use slide transitions. 

You can animate text, pictures, shapes, tables, SmartArt graphics 
and other objects to add pizzazz to your presentation. Adding 
animation simply means to add a special visual or sound effect to 
an object including entrance and exit effects, changes in size and 
colour, and even movement. For example, you may choose to 
reveal bulleted points on a slide one line at a time to control your 
presentation, or you could have an image of a ball bounce across 
the screen just to add some interest and movement. 

Another type of animation involves slide transition effects. By 
applying a transition to the slides, you control the way one slide 
moves to the next during the slide show. 

INFOCUS 
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UNDERSTANDING ANIMATIONS AND TRANSITIONS 
 

 

 

 

 

 

You can add a range of different effects to your 
presentation depending on what you are trying to 
achieve. Animation effects are used to animate 
text or objects within your presentations. 

Transition effects are used to transition from one 
slide to the next. Generally, a presentation will have 
more impact on the audience if you carefully select 
a few effects rather than using too many. 

Animations 

On the Animations tab, in the Animations gallery there are a range of effect options you can choose 
from to apply to the objects or text within your presentation. 

Each effect has an icon that indicates the way the effect works. The effects are grouped into the 
following four groups: 

Entrance Entrance effects control the way objects appear on your slide. For example, you may 
have individual lines of text fly in from the side of the slide, or have the slide titles 
gradually fading in as the slides display. 

Emphasis Emphasis effects control how the audience’s eye is drawn to the animated object. For 
example, you may make an image pulse or spin or have a line of text move in a wave 
shape. 

Exit Exit effects determine how the animated objects will leave the slide. For example, an 
image may bounce or shrink and turn off a slide. 

Motion 
Paths 

Motion paths control the movement of your text or objects around the slide. For 
example, you could make objects move up and down, move in a specific shape or even 
create your own custom path for an object to follow. 

If you can’t find the required animation effect in the Animations 
gallery, you can display the entire collection of each type of effect 
(such as entrance or exit) by selecting an option at the bottom of the 
gallery (such as More Entrance Effects) to open the Change 
Effects dialog box (see the example to the right). Here, the animation 
effects are grouped according to the impact of the effect – Basic, 
Subtle and Moderate – and for motion paths Basic, Lines & Curves 
and Special. 

Transitions 

The Transitions tab contains a gallery which displays a range of 
transition effects you can choose from. You can apply these effects to 
all or some of the slides within your presentation. The effects are 
grouped into three categories – Subtle, Exciting, and Dynamic 
Content. The best way to decide on the effect you want to use is to 
select it and preview it. To remove an effect from a slide simply select 
the slide and select None in the effects gallery. 

In the Timing group you can select certain timing options such as 
when the transition will begin, how long it will last and whether you 
want the effect to begin automatically or manually. 
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ANIMATING TEXT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Not only can animation help to make your 
presentation more dynamic, but you can use it to 
effectively control the flow of information. For 
example, you can animate each point of text to 

appear when you are ready to talk about it. This will 
ensure your audience listens to you rather than 
reading the remaining information on the slide. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file 
Animation_1.pptx… 

 
Navigate to and display slide 
2 in the Slide window 

 
Click on What is Renewable 
Energy, then click on the 
border of the text placeholder 
to select it 

 
Click on the Animations tab, 
then click on the More arrow 
for Animation to display the 
Animation gallery 

 
Click on Wipe under 
Entrance to apply the effect 

The text will be labelled with 
a non-printing numbered tag. 
You can also animate text 
paragraphs… 

 
Select the text box beneath 
What is Renewable Energy, 
then repeat step 3 

 
Click on Appear under 
Entrance to apply this effect 

Notice the text and each 
bullet has a different number 
as the effect is applied 
individually rather than to all 
of them as a whole 

 

3 

4 

For Your Reference… 

To apply animation to text: 

1. Select the text or text placeholder, then click 
on the Animations tab 

2. Click on the More arrow for Animation 

3. Click on an effect 

4. Click on Preview to preview the slide 

Handy to Know… 

 Animation tags only appear on a slide in 
Normal view when the Animations tab is 
selected or when the Animation task pane is 
opened. 

 Under normal circumstances, you should not 
animate points on the same slide with 
different effects. 

6 
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ANIMATING OBJECTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

As well as animating text, you can apply 
animation to objects either to emphasise a 
concept or just to grab the audience’s attention. 
Just be aware, however, not to overdo the 

animation in a presentation. Too much animation 
can be distracting – you want your audience to go 
away remembering the content of the presentation, 
not the excessive animations. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the 
file Animation_2.pptx... 

 
Click on slide 3 to display it in 
the Slide window 

 
Click on the picture to select it 

 
Click on the Animations tab, 
then click on the More arrow for 
Animation to display the 
Animation gallery, then click 
on Fly In under Entrance to 
apply the effect 

This effect would look better if 
the frog flew in from the left 
rather than from the bottom… 

 
Click on Effect Options in the 
Animation group 

The options listed in this gallery 
will depend on the effect that is 
applied… 

 
Select From Left 

 
Click on Preview in the 
Preview group to see the effect 
again 

The arrow will now appear from 
the left side of the slide. Notice 
also that the icon shown in the 
Effect Options tool on the 
ribbon reflects the change of 
direction 

 

3 

4 

For Your Reference… 

To apply animation to an object: 

1. Select the object, then click on the 
Animations tab 

2. Click on the More arrow for Animation 

3. Click on the desired effect 

4. Click on Preview to preview the effect 

Handy to Know… 

 You cannot set effect options for all 
animation effects. When this is the case, 
Effect Options will be greyed out in the 
ribbon. 

6 
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APPLYING MULTIPLE EFFECTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can apply more than one effect to the same 
object, but if you select the second effect from 
the Animation gallery, it will simply replace the 
first effect applied to the object. Instead, you 

must select additional effects from the Add 
Animation gallery. When multiple effects are 
applied to an object, Multiple will be selected in the 
Animation gallery rather than the effect names. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Animation_3.pptx... 

 
Click on slide 2 to display it in 
the Slide window 

 
Click on the image to select it 

 
Click on the Animations tab, 
click on the More arrow for 
Animation to display the 
Animation gallery, then click 
on Bounce under Entrance to 
apply the effect 

Let’s add another effect… 

 
Click on Add Animation in the 
Advanced Animation group to 
display the Add Animation 
gallery 

 
Click on Spin under Emphasis 
to apply an emphasis effect 

Let’s add an exit effect… 

 
Repeat steps 4 and 5 to apply 
the Shrink & Turn effect under 
Exit 

 
Click on Preview in the 
Preview group to see the 
effects again 

Currently, these effects need to 
be triggered individually. But 
we’ll fix this in another exercise 

 

3 

For Your Reference… 

To apply multiple animation effects to an object: 

1. Select the object 
2. Click on the More arrow for Animation and 

click on the desired effect 
3. Click on Add Animation and click on the 

desired effect 
4. Click on Preview to preview the slide 

7 

Handy to Know… 

 Use animations and sound effects sparingly. 
While well-placed animations can help to 
effectively communicate your message, too 
much animation can be off-putting. 

 To force multiple animation effects to work 
simultaneously as one effect, you must set 
timing options in the Animation pane. 
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APPLYING MOTION PATHS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

While effects like Fly In and Fly Out can control 
the movement of an object to a certain degree, 
motion paths give you total control. The centre of 
an object will follow the motion path. There are 

many pre-set motion paths and shapes from which 
you can select, plus an option for drawing a custom 
path. A motion path has a beginning and an end 
point which are shown as a green and red arrow. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the 
file Animation_4.pptx... 

 
Display slide 4 in the Slide 
window, then click on the text 
Available Renewable 
Technologies 

Let’s apply a motion path to this 
text so that it will come onto the 
slide and move into position… 

 
Drag the text box off the slide, as 
shown (you may have to zoom 
out to do this) 

We want the text to start from off 
the slide… 

 
Click on the Animations tab, 
click on the More arrow for 
Animation to display the 
Animation gallery, then click on 
Custom Path under Motion 
Paths 

 
Click and hold the left mouse 
button on the centre of the 
selected text, then drag to draw 
a C-shaped path similar to that 
shown, double-clicking at the 
end point to complete the motion 
path 

 
Click on Preview in the Preview 
group to test the effect 

The centre point of the text 
placeholder will follow the motion 
path 

 

2 

For Your Reference… 

To draw a motion path: 

1. Click on the text or object to be animated 

2. Click on the More arrow for Animation 

3. Click on Custom Path under Motion Paths 

4. Draw the path from the centre of the object 
and double-click at the end of the path 

Handy to Know… 

 If you are not happy with a motion path after 
previewing it, it is probably best to press 

 +  to undo the path and then start 

again. Although you can drag a handle of a 
selected motion path, it is not easy to edit the 
path by doing this. 

4 
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THE ANIMATION PANE 
 

 

 

 

 

 

 

When you add animations to objects on a slide, 
PowerPoint automatically numbers each 
animation with a numbered tag. These tags don’t 
tell you a lot about the animations except their 

order. By displaying the Animation pane, you can 
see at a glance a list of all animations on the slide 
along with information about the effects such as the 
type of effect, duration of the effect, and more. 

1 

 
Animation effects are listed in the Animation pane in the order that you added them to the slide and 
this is the order in which they will play. By default, the animation effects are numbered – these 
numbers match the numbered tags shown on the slide. 

 
The start timing icons indicate how an animation effect will be initiated. 

Start On Click  The animation effect will start when you click the mouse. This is

 the default value. 

Start With Previous (no icon) The animation effect will start when the previous effect starts. This 
 lets you combine multiple effects to work simultaneously as one 
 effect. 

Start After Previous  The animation effect will start immediately after the previous 

 animation has finished. 

 
The animation effects will play in the order in which they are listed in the Animation pane. If you 
want them to play in a different order, simply click on the effect that you wish to move and click on 
either the up arrow to move it up or the down arrow to move it down. 

 
The coloured blocks indicate the duration of the effect. If a gap exists between the end of one effect 
and the start of the next effect, this is because a Delay has been set in Timing. 

You can hide the coloured blocks by clicking on an effect and then clicking on the drop arrow and 
selecting Hide Advanced Timeline. 

 
Click on an effect to display the drop arrow then click on the drop arrow to display the menu. 

 
Seconds is a measure for the length of time (in seconds) that the animation effect lasts for. 

 

2 

3 

4 

5 

The Animation Pane 

You can display the animation pane by selecting a slide that has animation applied, clicking on the 
Animations tab and clicking on Animation Pane in the Advanced Animation group. The Animation 
pane displays by default at the right side of your screen, however you can move it to the top of your 
screen or display it as a floating pane. To do so, simply point to the Animation pane, then click and drag 
it to wherever you desire. When you open it again, it will display by default at the last place you 
positioned it. 

6 
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SETTING THE TIMING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you apply animations to objects, they are 
created to start with a mouse click by default. 
This is ideal if you want to control when text on a 
slide appears in a presentation. But if you want a 

heading to appear automatically when a slide 
displays or you want to combine several effects to 
play simultaneously, you will need to change the 
timing for the effect. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the file 
Animation_5.pptx... 

 
Display slide 2 in the Slide 
window, then click on the 
Animations tab and click on 
Animation Pane in the 
Advanced Animation group to 
open the Animation Pane 

 
Point to the Animation Pane title 
bar, then click and drag to the top 
of the screen to dock the pane 
below the ribbon 

 
Click on effect 1 in the 
Animation pane to select it, then 
click on the drop arrow and 
select Start With Previous 

The effect will be renumbered 
to 0… 

 
Click on effect 1, then repeat 
step 3 to select Start With 
Previous 

 
On the Animations tab, in the 
Timing group, click on the 
spinner arrows to set Duration to 
00.50 and click on the spinner 
arrows to set Delay to 01.50 

The timeline will shift… 

 
Click on effect 1 then repeat step 
3 to select Start After Previous 

 
Click on the first effect and click 
on [Play From] to see a preview 

 

3 

4 

For Your Reference… 

To set the timing for an effect: 

1. Select the effect 

2. Set Start, Duration and Delay in the Timing 
group on the Animations tab 

To display the Animation pane: 

1. Click on Animation Pane in the Advanced 
Animation group 

Handy to Know… 

 Duration is the time it takes for one cycle of 
an effect. For example, reducing the Spin 
duration will make an object spin quicker. 

 You can set the Start, Duration and Delay 
of an effect by clicking on it in the Animation 
pane, then clicking on the drop arrow and 
selecting Timing. 

5 

7 
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ANIMATING SMARTART GRAPHICS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Animating SmartArt is a bit different to animating 
other shapes and objects. For one, any 
connecting lines in a SmartArt can’t be animated 
individually, and secondly, you can’t change the 

order in which the individual shapes in a SmartArt 
appear – you can only reverse the order. You can, 
however, select whether the animation applies to 
the SmartArt as a whole, level by level and so on. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the 
previous file with this 
exercise, or open the file 
Animation_6.pptx... 

 
Display slide 8 in the Slide 
window, then click on the 
SmartArt to select it 

 
Click on the Animations 
tab, then click on the More 
arrow for Animation and 
click on Fade under 
Entrance 

The full graphic will be 
animated, indicated by the 
single animation tag, so 
let’s change that… 

 
Click on Effect Options in 
the Animation group to 
open the Effect Options 
gallery 

Currently, the animation is 
applied to the entire 
SmartArt… 

 
Select One by One 

Each circle will now fade 
in, one after the other, as 
indicated by the three 
animation tags 

 

2 

3 

For Your Reference… 

To animate a SmartArt graphic: 

1. Select the SmartArt 

2. Click on the More arrow for Animation 

3. If desired, click on Effect Options and select 
an option 

4. If desired, set the Timing options 

Handy to Know… 

 Not all of the animations are available for 
SmartArt. 

4 
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USING SLIDE TRANSITIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slide transition effects are an ideal way of giving 
your presentation a more polished and 
professional feel. You can set up the transition 
effects so that during your presentation they take 

place automatically or you can choose to activate 
them by clicking the mouse. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Animation_7.pptx... 

 
Display slide 1 in the Slide 
window, then click on the 
Transitions tab 

 
Click on the More arrow for the 
Transition gallery in the 
Transition to This Slide 
group to display a gallery of 
options 

 
Under Subtle, select Reveal 
to apply this effect 

 
In the Timing group, click on 
Apply To All to apply the 
effect to all slides 

 
In the Timing group click on 
the checkbox for On Mouse 
Click to that it appears without 
a tick, then click on the 
checkbox for After until it 
appears with a tick 

 
Click on the spinner arrow for 
After until it reads 00:10:00, 
then click on Apply To All 

You can check if the effect is 
applied to all by selecting a 
slide and checking the settings 
in the Timing group… 

 
Click on the Slide Show icon 
in the task bar to view the slide 
show and see the result 

 

4 

5 

6 

For Your Reference… 

To use slide transition effects: 

1. Select the slide 

2. Click on the Transitions tab, display the 
Transitions gallery and select an option 

3. Apply the desired settings in the Timing 
group 

Handy to Know… 

 You can change certain elements of an effect 
by clicking on Effect Options in the 
Transition to This Slide group to display a 
menu of options. You can then select an 
option to modify the effect. 
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CHAPTER 9 SETTING UP THE SHOW 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of self-running presentations 

 gain an understanding of recording a slide show 

 learn how to set up a self-running presentation 

 learn how to rehearse timings 

 learn how to set up a speaker-led show 

 learn how to create a custom show 

 gain an understanding of Presenter view 

 learn how to use Presenter view. 

Before delivering a presentation, you need to make sure that you 
set up the show for the required presentation mode, such as a 
speaker-led or a self-running presentation. This includes rehearsing 
and applying slide timings as required or recording narration for a 
presentation. 

INFOCUS 
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ABOUT SELF-RUNNING PRESENTATIONS 
 

 

 

 

 

 

Self-running presentations are commonly used at 
conventions and trade shows, or even the waiting 
room at your local doctor’s office. Self-running 
presentations are designed to run without a 

speaker present so the presentation should 
therefore provide enough time for the user to read 
the information, as well as to provide clear 
navigation cues for the audience if required. 

Setting Up A Self-Running Presentation 

For most self-running presentations, you will set up the slides to advance automatically after a specified 
period of time. This is done by assigning automatic timings to each slide. 

You can use the Rehearse Timings feature to apply the same timing to all slides. Alternatively you can 
assign variable timings to each slide, which is particularly useful where some slides contain less content 
than other slides (such as title slides). It’s a good idea to actually read through each slide when 
rehearsing timings to determine how much time it will take your audience to read and absorb the 
information. 

Adding Narration To A Self-Running Presentation 

You can also add narration to a self-running presentation. As everyone absorbs information in different 
ways (such as auditory or visual learners) this can help to deliver your message more effectively. To add 
narration, you can record the slide show. PowerPoint will record the amount of time that you spend 
viewing each slide, and at the same time you can record narration for the slides as required. PowerPoint 
will store the timing for each slide, and will also store the recording on each slide (displayed as a 
speaker icon on slides). Timings applied to each slide can be viewed in Slide Sorter view. 

Note that you will need specific hardware to record the narration, such as a sound card in your 
computer, a microphone and speakers. Hardware requirements are discussed in more detail on the 
following page. 

An alternative to recording the slide show is to record specific sounds or comments on relevant slides. 
This is achieved by selecting Audio and then Record Audio on the Insert tab. Again, you will require 
the necessary hardware as noted above. 

Enabling User Navigation 

If you want your audience to be able to navigate through a presentation at their own pace, you can 
disable any automatic timings and instead provide navigation cues for the audience, such as action 
buttons or hyperlinks. 

For example, you can insert an action button in the shape of an arrow with the word ‘Next’ as a cue to 
the audience that they can click on this button to advance to the next slide. Action buttons give the look 
and feel of a web page with easily recognisable navigation icons such as Home, Help, Next Page, Last 
Page, and so on. 

Alternatively, you can create hyperlinks for custom shows (which display specific slides within your 
presentation), other presentations, Microsoft Word or Excel files, specific addresses on the internet, or to 
email addresses. You can create hyperlinks from any object − including text, shapes, tables and 
pictures. 



Microsoft PowerPoint 2016 - Advanced 

© 2017 The University of Nottingham Page 97 Chapter 9 - Setting Up the Show 

RECORDING A SLIDE SHOW 
 

 

 

 

 

 
Hardware Required 

To enable you to record and play back the narration, you will require the following hardware: 

 A sound card installed on your computer. This enables you to hear sound. Most computers will 
already have this device installed. 

 Computer speakers. Most computers today have built-in speakers which should be enabled by 
default. You may need to check that the volume is working. You can do this by clicking on the 
Speakers icon (or similar) on the taskbar and check that the sound is not turned off (or muted), 
and then adjust the volume to the desired level. 

 A microphone to record your narration. For most computers, you can simply plug the microphone 
into the available microphone plug (a round plug with a microphone icon just above it or labelled 
‘mic-in’) at the rear of your computer (for desktop computers) or along the side or rear of your 
laptop computer. 

You can then begin recording your narration in PowerPoint. 

Recording The Slide Show 

The following is a guide to recording narrations for a slide show. 

1. When you are ready to record the narration for each slide, click on the Slide Show tab, then click 
on the bottom half of Record Slide Show. You then select Start Recording from Beginning or 
Start Recording from Current Slide. If you select the latter option, ensure that the required slide 
is displayed in the Slides window or selected in Slide Sorter view. 

You do not necessarily have to record in sequence. Also, you can pause during recording and 
resume at any time. 

2. The Record Slide Show dialog box will then appear asking you if you want to record narrations 
(Narrations and laser pointer) and timings (Slide and animation timings). To record both 
narrations and slide timings, leave both of these options selected and then click on [Start 
Recording]. 

3. The first (or selected) slide will appear, along with the Recording toolbar. The Recording toolbar 
will record the timings for each slide. You can advance to the next slide when you finish recording 
narration for the current slide, or Pause recording and timing. You can also re-record by clicking 
on Repeat. 

4. To end the recording at any time, press . 

Previewing The Narration 

Timings are saved and these will be displayed in Slide Sorter view. Any recorded narration will appear 
as a sound icon on the slide. To listen to a recorded narration, navigate to the slide, click on the sound 
icon, click on the Playback tab, then click on Play in the Preview group. If you are not satisfied with the 

recording, simply press  to delete it. To re-record narration for that slide, click on the Slide Show tab, 
then click on Record Slide Show and select Start Recording from Current Slide. 

Setting Up The Show 

By default, timings and narrations will be applied when you set up the presentation as a self-running 
presentation. To set up the presentation as a self-running presentation, click on the Slide Show tab, 
then click on Set Up Slide Show to open the Set Up Show dialog box. Click on Browsed at a kiosk 
option under Show Type. You can hide the sound icons on each slide by selecting the sound icon, 
clicking on the Playback tab and then clicking on Hide During Show in the Audio Options group so 
that it appears with a tick. 

If you are setting up a self-running presentation 
for viewing by a particular audience or the 
general public, you might decide it’s a good idea 
to add narration to the presentation. In this way, 

the presentation will be seen as well as heard. 
Here we give you an overview of how to record 
narration and timings for a self-running 
presentation. 
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SETTING UP A SELF-RUNNING PRESENTATION 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When finalising a self-running presentation, such 
as at a kiosk or trade show, the audience must 
have time to read and digest the content on a 
slide before the slide progresses to the next one. 

Where you have included action buttons, for 
example, users can simply click on the button to 
progress to the next slide. Alternatively, you can 
apply timings for slide advancement. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise you 

MUST open the file Setting Up 
The Show_1.pptx... 

 
Display slide 1 in the Slide 
window, then click on the 
Transitions tab and click on 
After in the Timing group until it 
appears with a tick 

We’ll set slide advancement for 
15 seconds… 

 
Click on the up spinner arrow for 
After until it reads 00:15.00 

 
Click on Apply To All in the 
Timing group to apply this timing 
to all slides 

Now we’ll set up the show as a 
self-running presentation… 

 
Click on the Slide Show tab, 
then click on Set Up Slide Show 
in the Set Up group to open the 
Set Up Show dialog box 

 
Ensure that Using timings, if 
present is selected in Advance 
slides, then click on Browsed at 
a kiosk (full screen) in Show 
type to select it, then click on 
[OK] 

Self-running presentations will 
loop continuously by default… 

 
Click on Slide Show in the status 
bar to preview the slide show, 

then press  when finished 

 

2 

4 

For Your Reference… 

To set up a self-running presentation: 

1. Click on the Transitions tab, click on After, 
set a timing in After, then click on Apply to 
All to apply to all slides 

2. Click on the Slide Show tab, click on Set Up 
Slide Show, select Browsed at a kiosk (full 

screen) and click on [OK] 

Handy to Know… 

 You can set different timings for each slide. 
This is useful when you want shorter slide 
progressions for title slides, for example. To 
do this, click on Slide Sorter View in the 
status bar, click on a slide to select it, click 
on the Transitions tab and apply the 

required timing in After in the Timing group. 

5 
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REHEARSING TIMINGS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Instead of applying the same timing to each slide 
or guessing an approximate timing for each one, 
you can use the rehearse timings feature to 
record exactly how much time is required to read 

or speak during each slide. These slide timings can 
then be automatically applied to the presentation if 
desired. This feature is useful for both self-running 
and speaker-led presentations. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file with 

this exercise, or open the file Setting 
Up The Show_2.pptx... 

 
Click on the Slide Show tab, then 
click on Rehearse Timings in the 
Set Up group 

The slide show will begin and the 
Recording toolbar will appear, 
showing the timing of the current 
slide as well as the overall slide 
show time... 

 
Pretend you are presenting the 
content on the slide, or pretend you 
are the audience reading the slide 
(such as at a kiosk), then click on 
Next on the Recording toolbar to 
progress to the next slide 

 
Repeat step 2 for each slide until 
you arrive at the last slide, then 
right-click on the slide and select 
End Show 

A message box will appear telling 
you the length of the show and 
asking if you want to keep the new 
timings... 

 
Click on [Yes] to save the timings, 
then click on the View tab and 
select Slide Sorter in the 
Presentation Views group 

The slides will appear in Slide Sorter 
view with the timings displayed 
below each slide... 

 
Switch back to Normal view 

 

1 

3 

4 

For Your Reference… 

To rehearse slide timings: 

1. Click on the Slide Show tab, then click on 
Rehearse Timings in the Set Up group 

2. Read/rehearse the presentation, and click on 
Next to progress through each slide 

3. Click on [Yes] to retain the timings 

Handy to Know… 

The Recording toolbar tools are as follows: 

 Next: to move to the next slide 

 Pause: to pause recording 

 Slide Time: displays the timing; you can 
also type an exact timing into this box 

 Repeat: to re-record the current slide. 
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SETTING UP A SPEAKER-LED SHOW 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The most common mode of presentation delivery 
is the speaker-led show. During this type of 
presentation, the speaker will manually advance 
each slide when required, thereby giving the 

speaker full control over the presentation. As such, 
timings for slide advancement will usually be 
disabled, however, the speaker can apply and 
rehearse timings if desired. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the file 
Setting Up The Show_3.pptx... 

 
Click on the Slide Show tab, then 
click on Set Up Slide Show in the 
Set Up group to open the Set Up 
Show dialog box 

First we need to select the type of 
show… 

 
Click on Presented by a speaker 
(full screen) in Show type 

This is the standard option for a 
speaker-led presentation. As the 
presenter will be speaking during 
the show, we’ll also disable the 
narration option… 

 
Click on Show without narration 
in Show options until it appears 
with a tick 

Although timings have been set, 
we’ll turn these off so that the 
speaker can manually advance 
each slide when required… 

 
Click on Manually in Advance 
slides to select this option, then 
click on [OK] to apply the settings 

 
Click on From Beginning in the 
Start Slide Show group to start 
the show 

 
Click to advance each slide, then 
press  to end the show 

 

3 

4 

For Your Reference… 

To set up a speaker-led show: 

1. Click on Set Up Slide Show in the Set Up 
group on the Slide Show tab 

2. Click on Presented by a speaker (full 
screen), then click on Manually 

3. Click on [OK] 

Handy to Know… 

 If you have applied animations to text and 
objects, it may take a significant time to get 
through the presentation. This is fine if you 
have plenty of time, but if you don’t you can 
disable the animations by selecting Show 
without animation under Show options in 

the Set Up Show dialog box. 
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CREATING A CUSTOM SHOW 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

By using custom shows, you can adapt a single 
presentation for numerous audiences. For 
instance, you could prepare a comprehensive 
presentation for your company and then create 

several custom shows from it – each show 
containing only the slides that are relevant for a 
specific department. If desired, you can still run the 
entire presentation in its original sequential order. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the file 
Setting Up The Show_4.pptx... 

 
Click on the Slide Show tab, 
click on Custom Slide Show in 
the Start Slide Show group, 
then select Custom Shows to 
open the Custom Shows dialog 
box 

 
Click on [New] to open the 
Define Custom Show dialog box 

 
Type Quick Version in Slide 
show name, then click on 1. 
Renewable Energy in Slides in 
presentation and click on [Add] 

 
Click on slides 4, 5, 6, 7 and 8, 
then click on [Add] 

 
Click on [OK] and click on 
[Close] 

Let’s change the set up so that 
starting the show will start the 
custom show... 

 
On the Slide Show tab, click on 
Set Up Slide Show in the Set 
Up group to open the Set Up 
Show dialog box 

 
Click on Custom show in Show 
slides, then click on [OK] 

 
On the Slide Show tab, click on 
From Beginning in the Start 
Slide Show group to play the 
custom show 

 

1 

3 

4 

For Your Reference… 

To create a custom show: 

1. Click on Custom Slide Show in the Start 
Slide Show group on the Slide Show tab 
and select Custom Shows 

2. Click on [New] 

3. Type a Slide show name, select the slides 

and click on [Add] 

Handy to Know… 

 You can hyperlink to a custom show from 
within a presentation. To do this, select the 
text or object to represent the hyperlink. Click 
on Hyperlink on the Insert tab, click on 
Place in This Document, select the custom 
show under Select a place in this 

document, and tick Show and return. 

7 
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UNDERSTANDING PRESENTER VIEW  
 

 

 

 

 

 

Presenter View is a very handy feature of 
PowerPoint that allows you to have greater 
control when you are presenting a slide show. 
Presenter view allows you to view a kind of 

backstage of the presentation which includes notes 
and a preview of the next slide, while the audience 
is watching the slide show itself so that you can 
always be prepared and in control. 

What Is Presenter View? 

If you have multiple monitors attached to your computer, Presenter View will display automatically when 
you run your slide show. This view enables you (as the presenter) to see much more information on your 
monitor than what the audience sees on their monitor (the presentation in full screen). Specifically, your 
Presenter View window, as shown below, displays: 

 the active slide (exactly as the audience sees it) 

 the next slide in the presentation 

 your speaker notes for the current slide and tools to increase or decrease their font size 

 the elapsed time and tools to pause and restart the timer 

 the current time 

 tools for annotating slides on the fly, displaying all slides, zooming into the slide, etc 

 controls at the top of the window enabling you to display the taskbar if you need to access another 
open program, swap Presenter View and Slide Show view if they appear on the wrong monitors, 
etc. 

Note: If you have only one monitor attached to your PC, Slide Show view will display by default when 
you run your slide show. However, if you want to rehearse your presentation in Presenter View, you can 
switch to Presenter View from Slide Show view by selecting Show Presenter View in the More slide 
options menu. 

Speaker 
notes for 
active slide 

Preview of 
the next 
slide 

Make text 
larger or 
smaller 

Navigation 
arrows 

End Slide 
Show 

Display 
Settings 

Show 
Taskbar 

Active slide 

Current 
time 

From left to right: Pen/Laser Tools, Show All Slides, Zoom 
Slide, Black or Unblack Slide Show, More Slide Options 

Timer Pause Timer Restart Timer 
  



Microsoft PowerPoint 2016 - Advanced 

© 2017 The University of Nottingham Page 103 Chapter 9 - Setting Up the Show 

USING PRESENTER VIEW 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Presenter View is a handy feature provided by 
PowerPoint which allows you more control when 
delivering your presentation. If you have two 
monitors attached to your PC, Presenter View 

will be displayed whenever you run your slide 
show. For this exercise, however, we will assume 
that your PC is connected to only one screen. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise you 

MUST open the file Setting Up 
The Show_5.pptx... 

 
Click on the Slide Show tab, 
then click on From Beginning in 
the Start Slide Show group to 
start the show in Slide Show 
view 

 
Right-click on the screen and 
select Show Presenter View to 
switch to Presenter View 

 
Click on the active slide to move 
to the next slide 

Let’s look at some tools beneath 
the active slide… 

 
Click on Pen and laser tools, 
select Laser Pointer to change 
the cursor to a red ‘laser’, then 
move the mouse over the slide 

 
Click on See all slides to see the 
slides in a view like Slide Sorter 
view, as shown, then click on 
slide 4 and click on the Next 
arrow to display slide 5 

 
Click on Zoom into the slide, 
then move the zoom marquee 
over the petrol pumps and click 
to zoom in 

 
Press  to zoom out again, 
then click on More slide show 
options to display a menu and 
select End Show to return to 
Normal view 

 

4 

5 

For Your Reference… 

To use Presenter View with only one monitor: 

1. Click on the Slide Show tab, then click on 
From Beginning in the Start Slide Show 
group 

2. Right-click on the screen and select Show 

Presenter View 

Handy to Know… 

 The auto-extend function automatically 
enables Presenter View when you connect 
a second monitor to your computer and 
ensures your presentation is projected 
correctly. Ensure Use Presenter View is 
ticked in the Monitors group on the Slide 

Show tab. 

7 
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CHAPTER 10 SAVING AND SHARING PRESENTATIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 learn how to package presentations for CD 

 learn how to save a presentation as a PDF document 

 learn how to save a presentation as a video 

 learn how to send a presentation via email 

 gain an understanding of how to broadcast a slide show 

 learn how to save a presentation to a storage device. 

PowerPoint enables you to save your presentation in a variety of file 
formats, such as a PDF document or a web-based presentation. 
You may need to do this to reduce file size when distributing it via 
email, or to ensure that your audience can view the presentation 
even if they don’t have PowerPoint installed. 

There are various ways that you can share your presentation with 
others, such as packaging onto a CD or broadcasting a slide show 
on the internet. 

INFOCUS 
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PACKAGING PRESENTATIONS FOR CD 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

With PowerPoint’s Package Presentation for 
CD feature, you can save the presentation onto a 
CD, network or local drive for others to view. 
When you save the presentation in this way, any 

linked files, media clips and the PowerPoint 
Viewer will be saved with it. PowerPoint viewer 
ensures the audience can read your presentation 
even if they don’t have PowerPoint installed. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise you 

MUST open the file Saving And 
Sharing Presentations_1.pptx… 

 
Click on the File tab, then click on 
Export to display the options for 
saving and sending presentations 

 
Click on Package Presentation for 
CD under Export 

The right pane displays information 
about what the package includes… 

 
Click on [Package for CD] to open 
the Package for CD dialog box 

For this exercise we will actually 
copy to a new folder instead of 
copying to a CD… 

 
Type Solutions in Name the CD, 
then click on [Copy to Folder] to 
open the Copy to Folder dialog box 

 
Click on [Browse], locate and click 
on the course files folder, then click 
on [Select] and click on [OK] 

A message box will appear 
confirming that you want to include 
linked files… 

 
Click on [Yes] to include linked files 

PowerPoint will copy all files and 
File Explorer will open the Solutions 
folder that you created… 

 
Close File Explorer, then click on 
[Close] to close the dialog box and 
return to your presentation 

 

1 

3 

For Your Reference… 

To package a presentation for CD: 

1. Click on the File tab, click on Export, click 
on Package Presentation for CD, then click 
on [Package for CD] 

2. Insert a CD if required, type the Folder 
name, click on [Copy to Folder] or [Copy to 

CD], click on [OK], then click on [Yes] 

Handy to Know… 

 When copying a presentation to CD, make 
sure you have a blank CD-R disk inserted in 
the CD drive. PowerPoint will automatically 
detect the CD. Once files have been written 
to a CD-R, they cannot be overwritten nor 
can files be added. You can also copy the 
presentation to a rewritable CD (CD-RW). 

4 
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SAVING A PRESENTATION AS A PDF DOCUMENT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To ensure that all of your audience can view your 
presentation or to enable you to reduce file size if 
you want to distribute it via email, you can save 
the presentation as a PDF document. So long as 

your audience has a PDF viewer installed (there 
are many types that are free to download), they can 
view a PDF version of the presentation, with the 
original layout and formatting preserved. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file with 

this exercise, or open the file Saving 
And Sharing Presentations_1.pptx... 

 
Click on the File tab, then click on 
Export 

 
Ensure Create PDF/XPS Document 
is selected in the middle pane under 
Export 

XPS is another universal document 
type, created by Microsoft… 

 
Click on [Create PDF/XPS] to open 
the Publish as PDF or XPS dialog 
box 

 
Leave the file name as is, click on 
Open file after publishing and 
Standard (publishing online and 
printing) to select them, then click 
on [Options] to open the Options 
dialog box 

Here you can review and change the 
publish settings, but we’ll leave them 
as they are… 

 
Click on [OK] to close the Options 
dialog box, then click on [Publish] 

PowerPoint will save the 
presentation as a PDF document 
and may automatically open it in 
your PDF viewer (if available). If not, 
open File Explorer, navigate to the 
course files folder and double click 
on the PDF… 

 
Browse the presentation, then close 
the PDF viewer 

 

3 

4 

For Your Reference… 

To save a presentation as a PDF document: 

1. Click on the File tab, click on Export, select 
Create PDF/XPS Document, then click on 
[Create PDF/XPS] 

2. Type a file name, navigate to the save 

location, then click on [Publish] 

Handy to Know… 

 PDF (Portable Document Format) is a 
universal document format owned by Adobe 
Systems that is designed to be viewed by 
anyone with a PDF viewer installed on their 
computer. Microsoft’s answer to a universal 
document format is the XPS document, 
which can also be viewed in any PDF viewer. 



Microsoft PowerPoint 2016 - Advanced 

© 2017 The University of Nottingham Page 108 Chapter 10 - Saving and Sharing Presentations 

SAVING A PRESENTATION AS A VIDEO 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PowerPoint provides you with the ability to save 
your presentation as a video. This might be 
useful if you want to upload the presentation to 
the internet or burn it onto a DVD. When you 

save the presentation as a video you can save it as 
an MPEG-4 Video (*.mp4) or a Windows Media 
Video file (.wmv), and it will include any narrations, 
audio, animations and transitions. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous file 
with this exercise, or open the 
file Saving And Sharing 
Presentations_1.pptx... 

 
Click on the File tab, then click 
on Export 

 
Click on Create a Video under 
Export to display the options 
for creating a video 

 
Read the information in the 
right pane and ensure the 
default settings are selected as 
shown 

 
Click on [Create Video] to 
open the Save As dialog box 

The default file type in Save as 
type will be MPEG-4 Video 
(*.mp4)… 

 
Type Solutions Video in File 
name, navigate to the course 
files folder, then click on [Save] 

If a message appears, click on 
[Continue without media]. 

It may take some time to save 
in this video format. You can 
check the progress of the save 
operation in the status bar… 

 
Once the operation is complete, 
open File Explorer, navigate to 
the course files folder and 
double-click on the video to 
open it 

 

For Your Reference… 

To save a presentation as a video: 

1. Click on the File tab, click on Export, click 
on Create a Video, then click on [Create 
Video] 

2. Type a file name, navigate to the desired 

save location, then click on [Save] 

Handy to Know… 

 If you do not want to distribute a video in the 
native .mp4 format, you can use third-party 
conversion software to convert the file into 
your preferred video format. 

 Video files will be much greater in file size 
than a presentation file. 

3 

4 

5 
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SENDING A PRESENTATION VIA EMAIL 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If your audience cannot attend your presentation, 
or you want others to review your presentation, 
you can easily distribute the presentation to them 
via email. By default, the presentation will be sent 

as a PowerPoint file, however, you can also choose 
to send the presentation as a PDF or XPS 
document if they do not have PowerPoint installed 
or if you want to reduce the file size. 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the previous 

file with this exercise, or 
open the file Saving And 
Sharing 
Presentations_1.pptx... 

 
Click on the File tab, then 
click on Share to display 
saving and sharing options 

 
Click on Email under Share 

Here you have a range of 
email options, such as 
sending the presentation as 
a PDF or XPS document. In 
this exercise you will send 
the presentation in its 
original file format… 

 
Click on [Send as 
Attachment] to open a new 
email message window 

The file is attached and a 
subject heading is already 
inserted, so you only really 
need to type the recipient’s 
email address and a 
message if required… 

 
Type your email address in 
To, then click on [Send] 

You can open your default 
email program to receive 
and open the email with the 
presentation attached 

 

1 

2 

For Your Reference… 

To send a presentation via email: 

1. Click on the File tab, click on Share, click on 
Email, then click on [Send as Attachment] 

2. Type the recipients’ email addresses in To, 
type a message if required, then click on 

[Send] 

Handy to Know… 

 When you save a presentation as a PDF 
document, the file size will be about half of 
the original file size. But if you have used 
images in your presentation, you will see no 
real reduction in file size. 

3 
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PRESENTING A SLIDE SHOW ONLINE 
 

 

 

 

 

 

PowerPoint provides two web-based viewing 
options. You can save your presentation for the 
web so that your audience can view your 
presentation at their own pace, or you can 

present a slide show online in real time. To use 
either of these options requires you to have a 
current Microsoft account. Here we discuss 
broadcasting a slide show. 

Overview 

Where your audience are scattered far and wide, you can deliver your presentation remotely and in real 
time. As long as your audience has internet access, you can send them a URL (web address or link) via 
email, and they can copy the link into their browser to view the presentation. Your audience therefore 
does not need to have PowerPoint installed to view the slide show. As you advance each slide, their web 
page will update automatically, so your audience will see what you see. 

What You Will Need 

To present a slide show online, you will need the following. 

 A Microsoft account, such as an Outlook account. This is because the broadcast is streamed 
via the Office Presentation Service which is hosted by Outlook. If you don’t have an Outlook 
account, you can create one by going to www.outlook.com and clicking on Sign Up. Note that 
your audience does not require an Outlook account to view the broadcast, they will only need the 
link (URL address) to the broadcast. 

 Supported browser which includes Internet Explorer, Mozilla Firefox and Safari for Mac. 

Beginning An Online Presentation 

To begin presenting a slide show online, follow these steps: 

1. Open your presentation in PowerPoint and make sure you are connected to the internet. 

2. Click on the Slide Show tab, then click on Present Online. The Present Online dialog box will 
appear. 

3. Depending on your preference, tick or un-tick the checkbox for Enable remote viewers to download 
the presentation. 

4. Click on Connect. PowerPoint will then attempt to connect to the Office Presentation Service. 

5. If you are not already signed in with your Microsoft account you will have to enter your Outlook email 
address and password. Click on [OK]. If all goes well, you will be connected to the Office 
Presentation Service, and the Present Online dialog box will include a link. 

6. Click on Send in Email. A new email message window will open with the link in the email body. Note 
that the link is not fully hyperlinked, so your audience will need to copy and paste the link into their 
browser. 

7. Type the email addresses of your audience in To. Edit the email as required. Click on [Send]. 

8. Click on [Start Slide Show] to begin the broadcast when the audience is ready. Right-click to display 
the shortcut menu and navigate the slide show as required. 

The Present Online Tab 

The contextual Present Online tab will appear when you connect to the Office Presentation Service. 
This tab contains options you may want to use during the presentation. For instance you can choose 
where to start the slide show, whether you want to display the slide show in Presenter View or whether 
you want to share meeting notes (if available). When you have finished presenting the slide show, click 

on End Online Presentation in the Present Online group. 
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SAVING TO A STORAGE DEVICE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Even though you regularly save your 
presentation to your computer, you should also 
periodically back up the presentation to another 
storage device such as a network drive, external 

hard disk or a USB flash drive. This ensures that 
should anything go wrong, you won’t lose your 
work and waste all that time and energy you put 
into creating the perfect presentation.  

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Saving And Sharing 
Presentations_1.pptx... 

 
Ensure that you have an 
appropriate storage 
device (e.g. USB flash 
drive) attached to your 
computer 

 
Click on the File tab to 
display the Backstage, 
then click on Save As to 
display the Save As place 

 
Click on This PC in the 
middle pane, then click on 
Browse to display the 
Save As dialog box 

 
Click on This PC (or 
equivalent) in the left 
pane, then scroll down the 
right pane until you find 
the USB 

 
Double-click on the USB 
to open it 

Here we’ve selected the 
USB flash drive which is 
identified as Removable 
Disk (F:) drive… 

 
If the storage device has 
folders, click on the folder 
that you wish to save the 
presentation to, otherwise 
click on [Save] 

 

2 

3 

For Your Reference… 

To save to another storage device: 

1. Ensure that the storage device is connected 
to your computer 

2. Click on the File tab and click on Save As 

3. Locate the storage device in the Save As 

dialog box and click on [Save] 

Handy to Know… 

 Be careful using Save As to save your 
presentation to a different location. The new 
location you choose will become the place 
where all subsequent Save operations occur. 
Use the Save As command again and save 
back to the original location to reset the 
Recent location for the presentation. 

5 
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CONCLUDING REMARKS 

 

 

 

 

 

 

 

 

Congratulations!  

You have now completed Microsoft PowerPoint 2016 - Advanced. Microsoft PowerPoint 2016 - 
Advanced was designed to get you to the point where you can competently perform a variety of 
operations.  

We have tried to build up your skills and knowledge by having you work through specific tasks. 
The step by step approach will serve as a reference for you when you need to repeat a task. 

 

Where To From Here? 

The following is a little advice about what to do next: 

 Spend some time playing with what you have learnt. You should reinforce the skills that you 
have acquired and use some of the application's commands. This will test just how much of 
the concepts and features have stuck! Don't try a big task just yet if you can avoid it - small 
is a good way to start. 

 Some aspects of the course may now be a little vague. Go over some of the points that you 
may be unclear about. Use the examples and exercises in these notes and have another go 
- these step-by-step notes were designed to help you in the classroom and in the work 
place! 

Here are a few techniques and strategies that we've found handy for learning more about 
technology: 

 read computer magazines - there are often useful articles about specific techniques 

 if you have the skills and facilities browse the Internet, specifically the technical pages of 
the application that you have just learnt 

 take an interest in what your work colleagues have done and how they did it - we don't 
suggest that you plagiarise but you can certainly learn from the techniques of others 

 if your software came with a manual (which is rare nowadays) spend a bit of time each day 
reading a few pages. Then try the techniques out straight away - over a period of time 
you'll learn a lot this way 

 and of course, there are also more courses and books for you to work through. 

Hungry for More? 

We live in an ever-changing world where we all need to review and upgrade our 
skills. 

If you have received this course book on a training course why not ask the tutor or 
trainer for other courses that may be of benefit to you. If you are attending a 
college ask for one of their brochures. 

Alternatively, if you’ve enjoyed using this course book you can find others that 
cover a wide range of topics at our web site www.watsoniapublishing.com. 

 

http://www.watsoniapublishing.com/
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